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Notes on the TIA Portal
1.1

1

General notes
The information in this readme file supersedes statements made in other documents.
Read the following notes carefully because they include important information for installation
and use. Read these notes prior to installation.

Windows 7 / Windows Server 2008 R2: Invalid certificate validation
The new certificates used for signing may possibly not be validated on the Windows 7 and
Windows Server 2008 R2 operating systems.
If you do not have the possibility to update the certificate store online, the signature of the
product files is displayed as invalid. In this case, update the root certificates provided by
Microsoft on the offline systems. To do so, follow the instructions in FAQ 109748887 (https://
support.industry.siemens.com/cs/ww/en/view/109748887).

Display of Asian characters in the TIA Portal
Due to a change in behavior in Microsoft Windows, it may occur that texts are not displayed
correctly in the TIA Portal when a Chinese TIA Portal is installed on another Asian operating
system (e.g. Korean). To view the texts in TIA Portal correctly, open the Windows Control
Panel and select "English" under "Language for non-Unicode programs". Note, however, that
this may cause display problems in other programs.

Installing new .Net versions or .Net service packs
● Close the TIA Portal before installing a new .Net version or a new .Net service pack on your
programming device/PC.
● Restart the TIA Portal only after successful installation of the new .Net version or the
new .Net service pack.

Notes on handling
● If a project in the list of projects last used is located on a network drive that is not connected,
you may experience delays when opening the "Project" menu.
● When you insert a CPU, you may need to wait for some time if the project editor is open at
the same time. This generally takes longer when you insert the first CPU in a newly created
project. To be able to continue working at a good pace, you should close the project text
editor before inserting a CPU.
● The alarm "Application is not responding" may appear in Windows 7 with functions that
take a long time to run (loading the CPU for example). If this occurs, wait until the function
has correctly finished.
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Notes on the TIA Portal
1.1 General notes
● If you have installed a Microsoft mouse with IntelliPoint, you may find that it superimposes
components over the buttons of the title bar. If this is the case, uninstall the IntelliPoint
software from Microsoft.
● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. In
this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver.

Working with automatically synchronized network drives
A TIA Portal project consists of multiple files that are saved together in one directory. If you
store a project that is automatically synchronized on a network drive or in a cloud directory
(e.g. Dropbox, Syncplicity or GoogleDrive), this can lead to data loss if the synchronization
only takes place partially or asynchronously. For this reason, we do not recommend editing
TIA Portal projects directly on synchronized network drives or in cloud directories. Always close
the TIA Portal project before synchronization and make sure that all directories and files from
the project directory are synchronized together and completely. You may wish to disable
automatic synchronization while working with the TIA Portal. The synchronization itself must
be implemented in such a way that the current (local) project data replaces the project data
on the network drive or in the cloud directory.

Entry of decimal places
With certain Windows language settings, it may occur that the entry of values with a comma
as decimal place is not recognized (entering "1,23" leads to an error). Instead, use the
international format ("1.23").

Information on the TIA Portal in online support
Overview of the most important technical information and solutions for the TIA Portal in the
Siemens Industry online support.
Internet link: TIA Portal in Siemens Industry online support (https://
support.industry.siemens.com/cs/ww/en/view/65601780)
All information on service and support in the Siemens Industry online support:
Internet link: Service and support in Siemens Industry online support (https://
support.industry.siemens.com/cs/de/en/)
Here, you can also subscribe to the newsletter that provides you with latest information relating
to your products.

Opening projects with missing software components
If a project cannot be opened in TIA Portal due to missing software components, you can
download and install it as trial software from Siemens Industry online support. You can then
open the project. Note that the trial software can only be used for a limited period of time.
Use the following link to open the page in Siemens Industry online support, where the various
software products are available to you as trial software: www.siemens.com/tia-portal-trial
(www.siemens.com/tia-portal-trial)
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Notes on the TIA Portal
1.3 Notes on memory cards

Starting the TIA Portal
When you start the TIA Portal, Windows attempts to update the Certificate Revocation List
(CRL) of "windowsupdate.com".
If no Internet access is available and there are multiple DNS servers, a timeout may occur and
delay the start of the TIA Portal.

1.2

Notes on libraries

Contents
Information that could not be included in the online help and important information about
product characteristics.

Comparing library elements
If master copies and types have the same name, the corresponding objects in the project are
overwritten when the action "Copy" is used. Please note that this takes place without a prompt.
The same behavior occurs when the name of the master copy is different to the name of the
type, but an object within the master copy has the same name as the type.

1.3

Notes on memory cards

Contents
Information that could not be included in the online help and important information about
product characteristics.

Notes on SIMATIC memory cards
The SIMATIC memory cards have been formatted and set up by Siemens for use with S7-1200
and S7-1500 modules. This format must not be overwritten; otherwise, the card will no longer
be accepted by the modules. Formatting with Windows tools is therefore not permitted.

Behavior in case of open force job
Note that an active force job is retained even after you have loaded a new project to the
SIMATIC memory card. This means you should first delete the active force job before you
remove a SIMATIC memory card from the CPU and before you overwrite the card in the PC
with a new project. If you use a SIMATIC memory card with unknown content, you should
format the SIMATIC memory card before the next download.
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Notes on the TIA Portal
1.4 Notes on the hardware configuration

Access protection for memory cards in USB card readers
By improving the security mechanisms for online access and engineering of S7-1500 CPUs,
the data storage on memory cards has been changed. For this reason, this version of STEP
7 cannot evaluate the passwords of the configured protection level when reading project data
from memory cards that is accessed via a USB card reader. The changed response affects
the memory cards for CPUs of the S7-1200/1500 series. Therefore, use physical safeguards
to protect critical project data on memory cards for these devices.
Note
This restriction is not related to online access to devices or the know-how protection of program
blocks.

1.4

Notes on the hardware configuration

Content
Information that could not be included in the online help and important information about
product characteristics.

Editing a device IP address
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP
address. If necessary, this address range is automatically assigned by the system to a
programming device. Depending on the subnet mask, this applies also for all network classes.

Drivers for the CP 5512 communications processor
The drivers for the CP 5512 are no longer included in this software version. If you want to use
the CP 5512, the following needs to be installed prior to the installation of this software:
http://support.automation.siemens.com/WW/view/78453460 (http://
support.automation.siemens.com/WW/view/en/78453460)
Please note that the CP 5512 can be used with a maximum of Windows 7 32-bit. As of Windows
8 or with 64-bit operating systems, the CP 5512 is not compatible.
Note
Since 2009, the functional successor the USB 2.0 module CP 5711 has been available.
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1.6 Notes on using the TIA Portal Teamcenter Gateway

1.5

Notes on using the TIA Portal in a virtual environment (private cloud)

Contents
Information that could not be included in the online help and important information about
product characteristics.

Instructions for using the TIA Portal in a virtual environment (private cloud)
You can find instructions on how to use the TIA Portal in a virtual environment (private cloud)
on the installation disk in the directory "Documents\Readme\<language directory>". You can
open the PDF document "TIAPortalCloudConnectorHowTo<language ID>.pdf" here.
The TIA Portal Cloud Connector can be used with the Windows 7 (64-bit) and Windows 10
(64-bit) operating systems.

Environment variables "TiaUserSettingsPath" and "TiaDefaultProjectPath"
The environment variables "TiaUserSettingsPath" and "TiaDefaultProjectPath" can be used
to set the location of the user and project settings different from the system default. This can
be used, for example, to save the user and project settings at a central location.
You can find additional information on the use of environment variables in the Instructions on
Using the TIA Portal in a Virtual Environment (Private Cloud).

Note on using self-signed certificates when using HTTPS as the communication protocol
Microsoft regularly checks whether the certificates in the Windows Certificate Store are from
a trusted source. Certificates from untrusted sources are deleted. Therefore, ensure that your
self-signed certificates are signed with a secure certificate.

1.6

Notes on using the TIA Portal Teamcenter Gateway

Contents
Information that could not be included in the online help and important information about
product characteristics.

Information on the installation of the TIA Portal Teamcenter Gateway
You can find instructions for installing the TIA Portal Teamcenter Gateway in the TIA Portal
Teamcenter Gateway online help under "Installing and uninstalling TIA Portal Teamcenter
Gateway".

Information on the use of the TIA Portal Teamcenter Gateway
This readme file provides information on using the TIA Portal Teamcenter Gateway.
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Notes on the TIA Portal
1.6 Notes on using the TIA Portal Teamcenter Gateway
The installation of the TIA Portal Teamcenter Gateway gives you access to the TIA Portal
Teamcenter Gateway function that is available as of TIA Portal V14 and higher.

Notes on installing the TIA Portal Teamcenter Gateway data model
You can find a description for installing the TIA Portal Teamcenter Gateway data model on the
installation data medium in the directory "\Support\Teamcenter_11\ServerSetupDocument\"
on the STEP 7/WinCC DVD2. Open the PDF document "Datamodel_Installation_enUS". The
instructions for installing the TIA Portal Teamcenter Gateway data model are only available in
English.

Note on updating the existing TIA Portal Teamcenter Gateway data model
Note the following:
● In the TIA Portal Teamcenter Gateway V15, no changes were made to the existing TIA
Portal Teamcenter Gateway data model and no changes specific to the Teamcenter as
well.

Notes on Teamcenter
Note the following:
● To work with the TIA Portal Teamcenter Gateway, Teamcenter Rich Application Client
(RAC) or Teamcenter Client Communication System (TCCS) as of version 11.2 must be
installed on your PG/PC.

Note on TCCS (Teamcenter Client Communication System)
Note the following:
● If you have completed the installation of TCCS (Teamcenter Client Communication System)
as a "standalone" installation, you also need to install "Microsoft Visual C++ 2013 –
Redistributable".

Note on UTF-8
Note the following:
● In order to display data from Teamcenter with non-English character sets, e.g. for Asian
languages, in TIA Portal, Unicode character sets need to be used.

Note on cloud computing
Note the following:
● If you run TIA Portal in a Cloud (for example virtual machine), this system has to be
integrated into the Teamcenter environment. Direct integration via a remote connection is
not supported by TIA Portal Teamcenter Gateway.
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Notes on the TIA Portal
1.7 Information on working with Multiuser Engineering

Notes on the basics of working with TIA Portal Teamcenter Gateway
As of TIA Portal Teamcenter Gateway version V15, the Teamcenter operation "Teamcenter >
Export..." is available for TIA Portal projects and global libraries.
With this operation, you create a copy of the current project, which is completely free of any
Teamcenter information. If you need to work separated from Teamcenter, use this operation
instead of "Save as" because "Save as" retains Teamcenter information in the project.

Setting the TIA Portal Teamcenter Gateway cache path
By default, the value entered under "Options > Settings > General > Teamcenter Gateway" in
the "TIA Portal Teamcenter Gateway Cache Path" area is taken as "TIA Portal Teamcenter
Gateway Cache Path".
By default, this value refers to the project directory path.
If you change the value of the "TIA Portal Teamcenter Gateway Cache Path", Teamcenter
Gateway checks the validity of the values entered by default and the changed values.
Note
The default value entered cannot be empty.

Note on TIA Portal Teamcenter Gateway operations during a started WinCC Professional simulation
Do not perform Teamcenter Gateway operations, such as "Check in" or "Undo check out"
during a started WinCC Professional Simulation.

1.7

Information on working with Multiuser Engineering

Contents
Information that could not be included in the online help and important information about
product features of Multiuser Engineering and about the multiuser server.
Installation of the Multiuser Server gives you access to the corresponding "Multiuser
Engineering" function that is available with TIA Portal.

Microsoft system account for multiuser server
When the multiuser server is installed, a Microsoft system account is created for the multiuser
server. Microsoft changes the password cyclically for this account.
If the password for this account has expired, the password needs to be changed and then the
multiuser server needs to be restarted.
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Notes on the TIA Portal
1.7 Information on working with Multiuser Engineering

Error message during start of the multiuser server
If an error message is displayed during or after the installation of the multiuser server indicating
that the service cannot be started for the Multiuser Server, the following procedure is
recommended:
1. Open the Windows event view and check whether an error entry with the error number
"1069" is present.
2. If this is the case, information on how to proceed is provided below.
Internet link: TIA Portal in Siemens Industry online support (https://
support.industry.siemens.com/cs/ww/en/view/65601780)
3. Alternatively, you can contact Customer Support directly.
Internet link to Customer Support: FAQ with ID 109739926 (https://
support.industry.siemens.com/cs/ww/en/view/109739926)

Working with active monitoring jobs and forcing jobs in the local session
Active monitoring jobs and forcing jobs must be closed before a check-in or update in the local
session. It is not possible to check in or update in the local session while monitoring or forcing
jobs are active.

Working in the local session with the "Keep local session" option
If the "Keep local session" option is selected after the check-in, all checked-in objects in the
local session appear as outdated, even if their content is identical.

Working with different versions of TIA Portal
Local sessions created with <x.y> version of TIA Portal can only be worked on with this version.
Example: A local session created with TIA Portal V15.1 for a V15.1 project cannot be edited
with an earlier version of TIA Portal.

Working with Multiuser Commissioning
● When you work with Multiuser Commissioning, a new revision of the server project is
created after each download to the CPU. However, a new revision is not created when
objects that cannot be marked were edited in the local session. Changes to objects that
cannot be marked are lost during check-in and are not downloaded to the CPU.
● When you start download to the device in Commissioning mode from the project tree with
the menu command "Download to device > Hardware configuration", the dialog which
informs you that different data exists on the CPU and in the server project is always
displayed.
● When you work in Commissioning mode, only S7-1500 CPUs are fully supported. When
using an S7-300/400 CPU, the dialog which informs you that different data exists on the
CPU and in the server project is always displayed in Commissioning mode. The reason is
that S7-300/400 CPUs do not support synchronization. To prevent this message from being
displayed, you should disable the option "Check for data mismatch before loading
(recommended)" in the Administration tool.
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Notes on the TIA Portal
1.8 Information about engineering options

See also
TIA Portal in Siemens Industry online support (https://support.industry.siemens.com/cs/ww/en/
view/65601780)
FAQ with ID 109739926 (https://support.industry.siemens.com/cs/ww/en/view/109739926)

1.8

Information about engineering options

Contents
Information that could not be included in the online help and important information about
product characteristics.

What's new at SINAMICS in AutomationML
Contrary to the statement in the section "What's new in TIA Portal V15" in the section "SIMATIC
TIA Portal Openness", V90 slaves and SINAMICS G120 PROFINET head modules cannot be
exported and imported using AutomationML.
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1.8 Information about engineering options
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STEP 7
2.1

Security information

Security information
Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions only form one element of such a concept.
Customer is responsible to prevent unauthorized access to its plants, systems, machines and
networks. Systems, machines and components should only be connected to the enterprise
network or the internet if and to the extent necessary and with appropriate security measures
(e.g. use of firewalls and network segmentation) in place.
Additionally, Siemens’ guidance on appropriate security measures should be taken into
account. For more information about industrial security, please visit
https://www.siemens.com/industrialsecurity (https://www.siemens.com/global/en/home/
company/topic-areas/future-of-manufacturing/industrial-security.html)
Siemens’ products and solutions undergo continuous development to make them more secure.
Siemens strongly recommends to apply product updates as soon as available and to always
use the latest product versions. Use of product versions that are no longer supported, and
failure to apply latest updates may increase customer’s exposure to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under
https://www.siemens.com/industrialsecurity (https://www.siemens.com/global/en/home/
company/topic-areas/future-of-manufacturing/industrial-security.html)

Network settings
The following tables show the network settings of each product you need to analyze the
network security and to configure external firewalls:
STEP 7 Professional
Name

Port number

Transport
protocol

Direction

Function

Description

ALM

4410*

TCP

Inbound/out‐
bound

License serv‐
ice

This service provides the complete function‐
ality for software licenses and is used by
both the Automation License Manager as
well as all license-related software products.

TCP

Outbound

S7 communi‐
cation

Communication to the S7 controller via
Ethernet/PROFINET for programming and
diagnostic purposes.

RFC 1006 102
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STEP 7
2.2 Notes on use
STEP 7 Professional
DCP

---

Ethernet

Outbound

PROFINET

The DCP protocol (Discovery and Basic
Configuration Protocol) is used by PROFI‐
NET and provides the basic functionality for
locating and configuring PROFINET devi‐
ces.

SNMP

161

UDP

Outbound

PROFINET

The SNMP client functionality is used by
STEP 7 to read status information from
PROFINET devices.

* Default port that can be changed by user configuration

WinCC ES Basic (without simulation)
Name

Port number

Transport pro‐ Direction
tocol

Function

Description

ALM

4410*

TCP

Inbound/out‐
bound

License serv‐
ice

This service provides the complete function‐
ality for software licenses and is used by
both the Automation License Manager as
well as all license-related software products.

HMI Load

1033

TCP

Outbound

HMI Load (RT
Basic)

This service is used to transmit images and
configuration data to Basic Panels.

* Default port that can be changed by user configuration

Simulation RT Basic
Name

Port number

Transport pro‐ Direction
tocol

Function

Description

HMI Load

1033

TCP

Inbound

HMI Load (RT
Basic)

This service is used to transmit images and
configuration data to Basic Panels.

Ethernet/
IP

44818

TCP

Outbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

2222

UDP

Inbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

Modbus
TCP

502

TCP

Outbound

Modbus TCP
channel

The Modbus TCP protocol is used for con‐
nections to Schneider PLCs.

RFC 1006

102

TCP

Outbound

S7 channel

Communication to the S7 controller via
Ethernet/PROFINET

Mitsubishi
MC

5002

TCP

Outbound

Mitsubishi MC
channel

The Mitsubishi protocol is used for connec‐
tions to Mitsubishi PLCs.

2.2

Notes on use

Contents
Information that could not be included in the online help and important information about
product characteristics.
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2.2 Notes on use

Online operation
The simultaneous online operation of STEP 7 V5.6 or earlier and STEP 7 Professional V15.1
has not been approved.

Simultaneous online connections on an S7-1200 CPU (S7-1200)
It is not possible to establish an online connection from multiple instances of TIA Portal
simultaneously to the same S7-1200 CPU.

Parallel use
If the term "Combo" appears in the name or license key of the software after installation, the
use of the following products/versions is permitted in accordance with Article 1.6 of the General
Terms and Conditions (see also setup text):
● STEP 7 Professional 2017
● STEP 7 Professional 2010
● STEP 7 Professional 2006

PLC migration
No instruction profile should be activated during PLC migration.
Deactivate your instruction profile before you perform the PLC migration. You can then
reactivate the profile again.

Removing/inserting the memory card
After removing or inserting a memory card, always perform a memory reset on the CPU in
order to restore the CPU to a functional condition.

Removing and inserting Ethernet modules
If Ethernet modules are removed and re-inserted during operation, you must boot the PC;
otherwise, the "Accessible devices" functionality in STEP 7 or NCM PC will not display all
devices. While the PC boots, Ethernet modules must be activated.

Loading project data with TIA Portal V12 and V13 (S7-1200)
If you load the project data of an S7-1200 CPU with TIA Portal V13, you can no longer use
TIA Portal V12 to access this data. To do this, first restore the factory settings of the CPU.
Read the additional information on this in the online help under "How to reset a CPU to factory
settings".
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Compatibility (S7-1200)
The device configuration and program of an S7-1200 CPU must always be configured with the
same STEP 7 version. Usually, TIA Portal makes sure that no version conflicts occur by
outputting appropriate notifications during loading to the device.
This automatic verification is not possible with S7-1200 CPUs with firmware version V1.x. In
this case, users themselves must ensure that no version conflicts occur.

2.3

Editing devices and networks

2.3.1

General information on devices and networks

Content
Information that could not be included in the online help and important information about
product characteristics.

S7-PCT IO-Link (S7-1200)
The S7 Port Configuration Tool is available for free download at the following link.
http://support.automation.siemens.com/WW/view/37936752 (https://
support.industry.siemens.com/cs/ww/en/view/32469496)

Port Configuration Tool PCT
If you use the PCT tool, make sure that you always use the current version that is available
free of charge with the following link:
http://support.automation.siemens.com/WW/view/32469496 (http://
support.automation.siemens.com/WW/view/en/32469496)
The PCT tool is available for installation on the DVD in the "Support" folder.

2.3.2

Information about OPC UA functions

Contents
Information that could not be included in the online help and important information about
product characteristics.
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Schema files used for OPC UA functionality
The OPC Foundation provides its members with schemes that manufacturers can use for their
respective server/client implementations. These files are used, for example, to validate
imported information models / node sets.
The following scheme files are used for TIA Portal version V15.1 or S7-1500 CPU firmware
version V2.6:
Scheme

Explanation

https://opcfoundation.org/UA/schemas/1.04/UANodeSet.xsd

XML scheme for NodeSet data

https://opcfoundation.org/UA/schemas/1.04/Opc.Ua.NodeSet2.xml

OPC UA ("CORE") Model from
2018-06-20

https://opcfoundation.org/UA/schemas/DI/1.1/Opc.Ua.Di.NodeSet2.xml

OPC UA for Devices ("DI") Model from
2018-06-06

PLC object not visible in the server address space
With very large projects, it can happen in rare cases that, despite successful compiling of the
project and successful downloading to the CPU, the CPU node or PLC object is not visible in
the address space of the OPC UA server. In this case the memory reserved for OPC UA in
the CPU is insufficient.
Diagnostics, e.g. using UaExpert, returns the "Failed" server status.
Remedy
Disable the standard SIMATIC server interface in the CPU properties if it is not required.
Reduce the quantity or size of the elements that contribute towards the consumption of OPC
UA resources. Reduce the file size to less than 250 MB and the number of nodes to fewer than
30000.
Examples:
● Reduce the number of tags in the address space of the OPC UA server, in particular of
tags with the data type structure.
To remove tags from the address space, disable the option "Accessible from HMI/OPC UA"
in the PLC tag table or in the data blocks.
With data blocks, you also have the possibility to remove the DB with all tags completely
from the address space. To do this, disable the option "DB accessible from OPC UA" in the
properties of the DB.
● Reduce the length of names of the elements in extensive data structures.
● Shorten the descriptions of the nodes.
● Reduce the number of implemented methods.

Resource bottleneck during connection with fast establishment and termination of connections
Error 0x80810000 (OpcUa_BadTcpNotEnoughResources) can occur during connection
establishment (OPC_UA_Connect) of the client CPU, although free connection resources are
still temporarily displayed.
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Possible cause
During the termination of an OPC UA connection (OPC_UA_Disconnect), the connection
resource used for this connection remains occupied for approx. 60 seconds.
This behavior is also called "Graceful Shutdown" and conforms to TCP RFC 793.
The following applies to the period of the Graceful Shutdown:
● The TIA Portal ("Diagnostics > Connection information" area) counts these resources that
are still occupied as free resources, so that you may not diagnose a resource bottleneck
even though there is a resource bottleneck.
● The instruction to terminate an OPC UA connection (OPC_UA_Disconnect) indicates that
the connection has been terminated with DONE=1.
However, the connection resource in the CPU remains occupied for approx. 60 seconds
after the transition DONE=0 => DONE=1.
Remedy
The described behavior quickly has an effect on connection and disconnection: Correct
termination of a connection still binds the connection resource used for 60 seconds.
If a client initiates connection establishment again in this phase, an additional resource is used,
since the resource of the disconnected connection is still being used. If connection and
disconnection occur in quick succession in your application and the above message occurs,
the frequency of this sequence should therefore be reduced if possible.

Description of the OPC UA instructions OPC_UA_ServerMethodPre and OPC_UA_ServerMethodPost
Declaration of the tags in the description of the "OPC_UA_ServerMethodPre" instruction:
Preparation of the server method call
Contrary to the tag declaration (table) described in the help for this server instruction, you
cannot declare an InOut tag "UAMethod_OutParameters". Otherwise, the method call is
rejected with an error message.
Declaration of the tags in the description of the "OPC_UA_ServerMethodPost" instruction: Post
preparation of the server method call
Contrary to the tag declaration (table) described in the help for this server instruction, you
cannot declare an InOut tag "UAMethod_OutParameters". Otherwise, the method call is
rejected with an error message.

Example program for OPC_UA_TranslatePathList
In the example program for OPC_UA_TranlatePathList, the call of the instruction
"OPC_UA_NamespaceGetIndexList" (#OPC_UA_NamespaceGetIndexList_Instance (...)) is
incorrect because not all required variant parameters are supplied.
The following applies to all client instructions: All required variant parameters must be supplied.
These are the parameters "NamespaceUris" and "NamespaceIndexes" in the case of the
"OPC_UA_NamespaceGetIndexList" instruction used.
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Restart of the OPC UA server
The OPC UA server is stopped at each download to the CPU (e.g. after downloading a
configuration or a block) and then restarts.
Please note that OPC UA clients cannot continue to use the running services for this server
in this case and that the resources therefore need to be released again.
These services need to be requested again:
● Re-initiate connection setup
● Regenerate subscriptions
● Recreate read/write jobs

2.3.3

Hardware detection of IO devices

Contents
Information that could not be included in the online help and important information about
product characteristics.

Incomplete hardware recognition at ET 200SP stations
With STEP 7 V15 you can use the online function "Hardware detection" to determine the station
configuration of IO devices and to import them in your project including all plugged modules.
If you import an ET 200SP via the hardware detection in your project, you have to complete
the determined station configuration manually yourself:
● Check and correct the configured potential group properties (light or dark BaseUnit) for
each slot. STEP 7 cannot determine through the hardware detection which BaseUnit
actually exists on which slot.
● Check at the interface module whether the suitable bus adapter was determined in the
hardware configuration (for example BA 2xRJ45 instead on the BA 2xFC really present).
● At a mixed configuration ET 200SP/ET 200AL with bus adapter BA-Send the ET 200AL
distributed modules are not recognized. Complete the station configuration manually,
meaning supplement the missing modules from the hardware catalog.

Modules/submodules with ET 200S (GSDML) are not detected
Although the following IO devices of the ET 200S (GSDML) are taken into account during
hardware detection, their plugged-in modules/submodules are not recognized. If such IO
devices are added to the project, any modules/submodules that may be used must be
subsequently taken from the HW catalog and configured.
Affected are:
● 6ES7 151-3AA00-0AB0 (with firmware V1.0)
● 6ES7 151-3AA10-0AB0 (with firmware V2.0)
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● 6ES7 151-3BA00-0AB0 (with firmware V2.0)
● 6ES7 151-3AA20-0AB0 (with firmware V3.0)
● 6ES7 151-3BA20-0AB0 (with firmware V3.0)

2.3.4

HW ID of type "Hw_SubModule" for an HMI Panel IO device

Contents
Information that could not be included in the online help and important information about
product characteristics.

Determination of the HW ID with the "Hw_SubModule" type for an HMI Panel IO device
The "ID" parameter of the PROFIenergy "PE_START_END" program block must be supplied
with the hardware identifier (HW ID) with the type "Hw_SubModule" of the IO device. The
hardware ID with the "Hw_SubModule" type of the HMI Panel IO device is not displayed in the
system constants on an S7-1500/S7-1200/ET200SP CPU, but it can be determined. To do
this, the symbol for the IO device in the HMI panel with the type "Hw_Device" is determined in
the list of PLC tags in the "System constants" tab and reduced by one, for example,
"HMI_1_IE_CP_1~PROFINET_Interface_1~IODevice -1".

2.3.5

Use of modules on the S7-1200

Content
Information that could not be included in the online help and important information about
product characteristics.

Use of modules on the S7-1200
The modules listed below are not supported on the S7-1200.
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Family

Module

Order number

S7-300 FMs

SM 338

6ES7 338-4BC01-0AB0

FM 350-1

6ES7 350-1AH03-0AE0

FM 350-2

6ES7 350-2AH00-0AE0, 6ES7 350-2AH01-0AE0

FM 351

6ES7 351-1AH01-0AE0, 6ES7 351-1AH02-0AE0

FM 352

6ES7 352-1AH02-0AE0

FM 355 S

6ES7 355-1VH10-0AE0

FM 355 C

6ES7 355-0VH10-0AE0

FM 355-2 C

6ES7 355-2CH00-0AE0

FM 355-2 S

6ES7 355-2SH00-0AE0
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Family

Module

Order number

S7-300 PtP-CP

CP 340

6ES7 340-1AH02-0AE0, 6ES7 340-1BH02-0AE0, 6ES7
340-1CH02-0AE0

CP 341

6ES7 341-1AH01-0AE0, 6ES7 341-1AH02-0AE0, 6ES7
341-1BH01-0AE0, 6ES7 341-1BH02-0AE0, 6ES7
341-1CH01-0AE0, 6ES7 341-1CH02-0AE0

Network component

Diagnostics repeater 6ES7 972-0AB01-0XA0

ET 200M

SIWAREX

7MH4900-2AA01, 7MH4900-3AA01, 7MH4950-1AA01,
7MH4950-2AA01

Loading S7-1200 module comments to the PG/PC
In central configurations with S7-1200, comments of modules, submodules and signal boards
are not loaded. With CPs/CMs, only the comments of the IE interface or DP interface are
loaded. In distributed configurations with ET 200SP or ET 200MP, only the comment of the
channels is loaded from the I/O modules.

2.3.6

CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX

Contents
Information that could not be included in the online help and important information about
product characteristics.

CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX
The module AS-Interface CP 343-2 (article no.: 6GK7 343-2AH01) can be inserted in an
expansion rack of the SIMATIC S7 Embedded Controller EC31-RTX (article no.: 6ES7
677-1DDxx-0BB0), but the CP 343-2 cannot be operated with the EC31-RTX.

2.3.7

Loading of S7-1500 CPUs (SIPLUS)

Contents
Information that could no longer be included in the online help and important information about
product features.

Behavior of a SIMATIC S7-1500 CPU SIPLUS (6AG1...) FW <V2.5 with formatted memory card
Components involved:
● CPU 151x SIPLUS (6AG1...) with firmware version prior to V2.5
● SIMATIC memory card
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If you load a SIPLUS CPU to a formatted SIMATIC memory card and then set the CPU to
RUN, the CPU runs without errors. But once the power supply has been switched off and on
again or if a memory reset (MRES) has been performed, the SIPLUS CPU goes into STOP
with an error message. The error message states that the memory card is not recognized
because it is missing, is of an incorrect type, contains incorrect data or is protected.
This behavior does not occur with a CPU 151x SIPLUS (6AG1...) with firmware version V2.5
or higher or if a configuration with a S7-1500 SIMATIC CPU (6ES7...) already exists on the
memory card and is overwritten by a configuration with a SIPLUS CPU (6AG1...) of the same
type.
Remedy:
1. A configuration with SIMATIC CPU must be loaded on the SIMATIC memory card. Only a
CPU of the corresponding type must be available; the I/O is not required in this case.
2. The SIPLUS CPU is loaded to the card. The existing SIMATIC configuration on the memory
card is overwritten with the SIPLUS configuration.
This procedure prevents an error message of the TIA Portal.
Note
The procedure ONLY works for online loading to the CPU. The error remains if the card is
programmed by means of an external card reader.
If you want to load a CPU 1511-1 PN SIPLUS (6AG1 511-1AK00...), for example, do the
following.
1. Insert a blank memory card with sufficient available memory into the SIPLUS CPU.
2. Configure a SIMATIC CPU of the same type, here an S7-1511-1 PN (6ES7 511-1AK00...).
I/O modules are not required for the first load step.
3. Load the configuration onto the SIPLUS CPU.
4. Replace the SIMATIC CPU in STEP 7 with the SIPLUS CPU (6AG1 511-1AK00...) and
complete the configuration with the planned I/O modules and distributed I/O devices.
5. Load the changed configuration onto the SIPLUS CPU.

2.3.8

ET 200MP (IM 155-5 DP ST) on a WinLC RTX

Contents
Information that could not be included in the online help and important information about
product characteristics.
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ET 200MP (IM 155-5 DP ST) can currently not be operated on a WinLC RTX via PROFIBUS.
Components involved:
● PC systems with logic controller functionality WinLC RTX as DP master (all versions: EC31RTX (F), WinAC RTX (F) software PLC), referred to as "WinLC RTX" below.
● ET 200MP (IM 155-5 DP ST) as DP slave
If you configure standard modules or F-modules in an ET 200MP and use a WinLC RTX as
DP master, these modules are not configured by the DP master in the ET 200MP. After loading
the configuration and startup of the components involved, the modules in the ET 200MP signal
the missing parameter assignment by means of flashing green LEDs.
STEP 7 does not show the readiness for operation of the modules online (status "OK").
Remedy:
● Recommendation: Use an IM 155-5 PN interface module to connect the ET 200MP to a
WinLC RTX via PROFINET IO.
or
● If no F-modules are inserted in the ET 200MP: Use the GSD version of the ET 200MP on
an WinLC RTX to configure the standard modules.

2.3.9

Compiling ET 200SP HF V2.1 and higher, ET 200SP HS V4.0

Contents
Information that could not be included in the online help and important information about
product characteristics.

Compilation error for ET 200SP HF V2.1 and higher, ET 200SP HS V4.0
Affected components:
● ET 200SP HF V2.1 and higher
● ET 200SP HS V4.0
A compilation error can occur in isochronous mode of the ET200SP (ET 200SP HF V2.1 and
higher, ET 200SP HS V4.0) with the setting "From OB" even if the settings are valid. The typical
error message is: "The specific Ti value is invalid" or "The specific To value is invalid". But
other error messages are possible as well.
Remedy:
Upgrade the module description of the ET200SP header module in this case. You can upgrade
the module description of the ET 200SP header module in the network view or in the device
view of the Inspector window with the function "Update module description". The error can still
occur with the current module description after the first compilation. If you have selected valid
settings, the error will no longer occur with the subsequent compilation.
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2.3.10

Notes on online and diagnostics

Contents
Information that could not be included in the online help and important information about
product characteristics.

Hardware detection followed by online connection
When the "Online > Hardware detection" command is performed for an unspecified CPU, the
online configuration is not loaded from the CPU. If you do not load the configuration resulting
from the hardware detection to the CPU, the device and network views will always show a
difference between the offline and online configurations. It will appear that there are different
configurations in the online and diagnostic views, although the MLFBs are identical in the actual
CPU and the offline CPU.

Deleting measurements in the device (memory card) (S7-1200)
Do not delete any measurements in the device as long as a trace in the device still generates
new measurements on the memory card.

2.3.11

Network components

2.3.11.1

Network and communication modules

Online connections for special diagnostics and firmware loader
Special diagnostics: Establishing an online connection
Some network components (S7-300/400 CPs, PC CPs, gateways) provide expanded
diagnostics data in special diagnostics.
Requirement:
A PG/PC interface is physically connected to the destination device, e.g. via an Ethernet cable.
Procedure:
Follow the steps outlined below to start special diagnostics:
1. Open the online and diagnostics view of the module.
2. In the "Functions" folder, select the group "Special diagnostics".
3. In the "Special diagnostics" area, click the "Start special diagnostics" button.
As of STEP 7 Professional V14 for several CPs only one online connection can be established
from the engineering station via the CP. This connection can be established either with STEP 7
or special diagnostics.
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If special diagnostics is not started by the steps listed above and an error message is output
follow the steps below:
1. Disconnect the existing online connection to the station.
2. Open the online and diagnostics view of the module again as described above and start
special diagnostics.
32-bit applications; NCM S7 diagnostics, firmware loader
If you have established a connection to a PC CP from a 32-bit application and want to establish
another online connection via the same interface of the PC CP, you must first terminate the
connection of the 32-bit application.

Special diagnostics and firmware loader: Chinese GUI
When you open the special diagnostics or the firmware loader with a Chinese GUI, you need
to set the language for non-Unicode applications in the operating system to Chinese.

S7-CM/CP
No S7 routing with CP 300/400 < V3 as router
With S7 routing between S7‑1200 or S7‑1500 stations, no connection is established when
older S7‑300/400 CPs are connected in between as routers. The following types of
communication that run over ISO transport or ISO-on-TCP connections are affected:
● S7 communication
● PG communication
● HMI communication
The behavior applies to S7‑300/400 CPs with a firmware version < V3.0 for which the TSAP
length is limited to 2 bytes.
In contrast, like the S7‑1200/1500, S7‑300/400 CPs as of V3.0 support long TSAPs and thus
also S7 routing.

CM 1542‑1: Remove retentive storage of the IP address if there are duplicate addresses
The IP address and the device name of the CM 1542-1 remain installed retentively:
If, for example during startup, the CM detects a duplicate address in another network, the CM
is not connected to the network. The CM changes to RUN and cannot be reached via the
Ethernet interface.
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To be able to connect the CM to the network, you can remove the retentively stored IP address
as follows:
1. Remove the memory card of the CPU.
2. Using DCP with the Primary Setup Tool (PST) and with the CPU in STOP, set the IP address
of the CM to 0.0.0.0 without configuration.
You have removed the retentively stored IP address of the CM. The CM can be connected
into the network.
3. Insert the memory card in the CPU again.

PC CPs and applications
PC CPs for VMware vSphere Hypervisor ESXi
The following communications processors have been released for operation with VMware
vSphere Hypervisor ESXi for STEP 7 Professional V14:
● CP 5711
● VMware E1000 network adapter
The following communications processors have not been released for operation with VMware
vSphere Hypervisor ESXi:
● CP 5611
● CP 5612
● CP 5621
● CP 5622
● CP 5512
Other communications processors such as the CP 1623 and CP 1628 are released following
installation of the SIMATIC NET PC software. You will find information on this in the readme
file of the SIMATIC NET PC software.

Download to PC stations
If you download project data to a PC station with PC-CP, make sure that the CP is available.
In the "Extended download to device" dialog, do not enable the check box for the search for
compatible nodes.
If you want to download to a different CP from the one selected earlier in the project, change
the IP address of the CP manually in the "Extended download to device" dialog in the list of
configured access nodes.

PROFIBUS S7 connections with OPC servers
The configuration of an S7 connection via PROFIBUS is not possible between an OPC server
as of V12 and an S7‑1200 as of V4 or an S7‑1500.
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Remedy: Use an OPC server / PC application < V12 or use an S7‑1200 < V4 or an S7‑300 or
S7‑400 as the S7 station.

Visibility of PLC tags for OPC UA communication
If in the S7 communication between a PC station and an S7 station you configure PLC tags
with the option "Reachability from HMI/OPC UA" deactivated, this does not affect the visibility
in the OPC UA server of the PC station.

Access rights of an OPC client for access to PLC tags
If you want to write PLC tags of S7 stations that are provided via S7 communication in the
OPC UA server of a PC station from an OPC client, make sure that the following settings are
made in the configuration of the tags:
● The option "Can be written from HMI/OPC UA" is activated for the PLC tags.
● The access right "Read/Write" is activated in the symbol configuration of the OPC UA server
application of the PC station.

Security modules
Migration of projects with Ethernet CPs and activated security functions
In STEP 7 V5.5 projects that contain Industrial Ethernet CPs with activated security functions,
the security settings are disabled during migration to STEP 7 Professional.
If necessary, follow these steps after the migration:
1. Activate the security functionality.
2. Configure the required security settings.

Migration of IP access protection lists when activating the security functions
An active IP access protection list is converted to firewall rules when security functions are
activated. These rules are visible in advanced firewall mode and can be adjusted there. The
advanced firewall mode is activated automatically.

Security online diagnostics of S7 CPs
Security online diagnostics of a CP with security capability is only possible if the online
connection is established directly via the CP. If the online connection was established by
STEP 7 via the CPU to the station, with the "Connect online" button on the security diagnostics
page "Security" > "Status" of the security CP you can establish a direct connection to the CP
to run security online diagnostics. As an alternative, you can also terminate the online
connection to the CPU and enter the IP address of the CP in the "Station address" input box
under the entry "Online access" in online diagnostics.
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IKE mode
When negotiating the key in phase 1 the IKE mode "Main" should be preferred. This mode
normally provides a reliable procedure compared with the "Aggressive" mode. One reason for
using the "Aggressive" setting is when you have VPN groups with different pre-shared keys.
The IKE "Aggressive" mode should not be used in conjunction with certificates. In the IKE
"Aggressive" mode, only use pre-shared keys.
A security module must not be used in VPN groups that use different IKE modes.

Downloading configuration data to an S7-300/400 via a VPN tunnel
When you download configuration data via the gigabit interface of a CP x43-1 Advanced to an
S7-300/S7-400 station, the path via which the download takes place is stored in the project.
If the project is then downloaded via a VPN tunnel established between a SCALANCE S
module and the CP x43-1 Advanced, the download fails due to the changed path.
To download via the VPN tunnel, follow the steps below:
1. Using the "Go online" button, connect the engineering station to the gigabit interface of the
CP x43‑1 Advanced.
2. Disconnect the online connection to the CP x43‑1 Advanced.
3. Download the project to the station via the gigabit interface of the CP x43‑1 Advanced.

VPN tunnel establishment with 1200/1500 CPs capable of VPN
The establishment of VPN tunnel connections by 1200/1500 CPs capable of VPN with the
authentication method "pre-shared key" is only possible if the VPN connection partner is also
a 1200/1500 CP capable of VPN. The establishment of VPN tunnel connections by a
1200/1500 CP capable of VPN to all other VPN connection partners is only possible with the
"certificate" authentication method.

Security configurations from old projects
Before a security configuration from an older STEP 7 version in STEP 7 V14 can be used, a
user with administrator rights needs to log in to this security configuration in STEP 7 V13 SP1
and save the project. After opening the project in STEP 7 V14, a user must log on again to the
security configuration with administrator rights. Thereafter, it is possible to use this security
configuration in STEP 7 V14.

Copying security modules between STEP 7 instances
Copying security modules between different instances of STEP 7 is not supported.
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Device certificates for CP 1543-1 V2.0 and CP 1543SP-1
For CP 1543-1 V2.0 and CP 1543SP-1, only those device certificates that are assigned to the
module via the local certificate manager as device certificates are loaded to the module. This
assignment takes place in the local security settings of the module in the "Certificate manager"
entry via the "Device certificates" table editor. The certificates of the global certificate manager
are available for the certificate assignment.

No fallback VPN profiles for CP 1200/1500
Fallback VPN profiles are not supported by the CP 1200/1500. Configured fallback VPN
profiles are therefore not loaded on the CP 1200/1500.

Media converters
When you migrate a project, you need to reconfigure the media converters.

2.3.12

Notes on the S7-1500R/H redundant system

Content
Information that could not be included in the online help and important information about
product characteristics.

S7-1500R/H redundant systems
GRAPH blocks, ProDiag blocks and the "Program_Alarm" instruction are not supported in
V15.1 of S7-1500R/H-CPUs. If your program contains one of these elements, a compilation
message notifies you of this.
You can find additional information under "Principle of operation of the redundant S7-1500R/
H system" and "Programming S7-1500R/H CPUs" in the information system and in the section
"Basics of program processing" in the S7-1500R/H system manual.

2.4

Programming a PLC

2.4.1

General notes on PLC programming

Contents
Information that could not be included in the online help and important information about
product characteristics.
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Compiling blocks
If the message "The network is not supported in this version" is displayed, use a TEMP tag of
the BOOL data type to distribute multiple assignments that are not connected to the first
Boolean input of the instruction across several networks.

Instance-specific attributes when importing blocks via TIA Openness
In certain situations, the import rules can mean the loss of instance-specific attributes, such
as start values.

Display of the CPU name in system alarms
As of V15.1, the name of the CPU (or for H or R CPUs, the name of the station) is displayed
in the "Additional text 1" column of the system alarms. To do this, you need to compile the
hardware of the device in question. If the CPU name is not displayed via the "Compile >
Hardware (only changes)" option, use the option "Compile > Hardware (rebuild all)".
Make sure that loading to the device is actually performed; the message that the hardware is
up-to-date is not enough!

Modifying the application cycle of an isochronous cycle interrupt OB
When you change the "Application cycle (ms)" parameter of an isochronous cycle interrupt
OB, you implicitly also modify the hardware configuration. To ensure that the modified value
for the application cycle duration becomes effective after the next loading process of the CPU
you have to explicitly include the hardware configuration in loading. To this purpose select
either the menu command "Load to device > Hardware and software" or the command "Load
to device > Hardware configuration".

Information for setting breakpoints in the standard user program at S7-1500 F-CPUs
If a breakpoint is enabled and is reached, the CPU immediately goes to "STOP" after "HOLD".
If you want to change back to RUN mode after the "HOLD" in order to continue testing your
default user program, you can simulate this with S7-PLCSIM.
Further information about testing with breakpoints at F-CPUs is available in the "SIMATIC
Safety – Configuring and Programming" manual.

Using the system data type "TDiag_StatusExt" (S7-1200/1500)
Alternatively to the "TDiag_Status" system data type, the extended system data type
"TDiag_StatusExt" can be used to obtain more detailed information about the cause of a lost
connection. In particular, the reading out of the structure element "LastConnErrTimeStamp"
causes the CPU to switch to "Defect" system state and must not be used currently.
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Total size of the associated values for ProDiag (S7-1500)
The alarm procedure of the S7-1500 CPU allows a maximum of 512 bytes for associated
values. For internal information, ProDiag requires part of this associated value total. This
means that the three possible associated values in the specific text field can use a maximum
of 400 bytes.
This value was not validated in TIA Portal V14 during compilation. As of TIA PortalV14 SP1,
there is a corresponding validation, which returns an error if this value is exceeded.
This must be taken into account during migration of projects from version 14 to version 14 SP1.

Upgrading know-how-protected blocks (S7-1200/1500)
After an upgrade from V13 SP1 to a version <V15, know-how-protected devices that have
been set up with a version >=V15 can be loaded in the controller without entering a password
and are executable. To edit a know-how-protected block in >=V15, remove the know-how
protection and set it again. The block can then be renumbered and renamed in know-howprotected state.
● For know-how protected blocks that were set up with V13 SP1:
– To edit the know-how-protected block in >=V15, remove the know-how protection and
set it again. The block can then be renumbered and renamed in know-how-protected
state.
● For know-how protected blocks that were set up PRIOR TO V13 SP1:
– To edit, remove the know-how protection in V13 SP1 and reset it when done.

Upgrading of GRAPH blocks (S7-300, S7-400, S7-1500)
After upgrading a project to V15.1 from a version lower than V15, check whether repaired
GRAPH blocks are listed in the log file and test whether these blocks are executable in your
program.
If a project contains GRAPH blocks and is upgraded from V15.0 to V15.1, the program blocks
have to be compiled before they can be monitored.

Information about network security
For communications access between TIA Portal and CPU or between HMI (except for HMI
access using "GET/PUT communication") and CPU, there are integrated security functions.
These provide greater protection from manipulation and higher access protection. To protect
against unauthorized network access to a CPU with standardized communications access
such as "GET/PUT", "TSEND/TRCV", "Modbus", "FETCH/WRITE", you should also take
suitable additional measures (e.g. cell protection concept).

Functions from the global library "Long Functions" with PLCSIM (S7-1500)
The compilation process links the functions of the S7-1500 CPU family to the CPU to protect
them from manipulation. Function from the global library "Long Functions" that are used in the
CPU and have such a link cannot be loaded to a simulation. However, it is possible to replace
such elements with their originals from the global library. These are not linked to a CPU.
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Loading inconsistent programs to an S7-1500 CPU (S7-1500)
In TIA Portal, it is not possible to download inconsistent programs to an S7-1500 CPU without
a consistency check. During the loading process, all blocks of the program are implicitly
checked and are compiled again in the event of inconsistencies. If, however, there are
programs on your CPU which were loaded with earlier versions of STEP 7, these programs
could demonstrate inconsistencies.
In this case, note the following:
If you load an inconsistent program from a device, you will not be able to load the program
back to an S7-1500 CPU unchanged afterwards, because a consistency check always takes
place during the loading process and existing inconsistencies are corrected.

Changed access rights for displaying the comparison status (S7-1200/1500)
Valid for:
● CPU 1500 < V2.0 (as well as ET200 SP and Software Controller)
● CPU 1200 V4.0 and V4.1
As of TIA Portal V14, the required access rights for displaying the comparison status of blocks
have changed for the specified CPUs from the S7-1200/1500 series.
Previously, you only needed the "HMI access" access level for the listed CPUs to display the
comparison status. As of V14, you need the "read access" access level to display the
comparison status.
This change means that you are prompted to enter the password for "read access" when you
go online.
If you only have the password for "HMI access", you can still establish an online connection.
In this case, click "Cancel" in the password prompt for read access and enter the password
for "HMI access" in the subsequent dialog. The online connection is then established with the
available "HMI access rights", but no comparison status of the blocks is displayed.
Only questions marks are displayed in place of the icons for the comparison status.
Valid for:
● CPU 1200 <=V3.x.
As of TIA Portal V14, there is now a password prompt for the above specified CPUs when you
go online for displaying the comparison status of blocks, provided that these CPUs are
configured with write protection and/or read protection.
If you do not know the password for access to read-protected blocks on a protected CPU, you
can still establish an online connection.
In this case, leave the displayed password prompt dialog with "Cancel".
The online connection is still established, but no comparison status of the blocks is displayed.
Only questions marks are displayed in place of the icons for the comparison status.
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Data exchange between standard and F-program when using Team Engineering
To ensure data consistency between standard and safety program, you should:
● Do not exchange data via bit memory, use global data blocks instead.
● Limit access between safety programs and standard user programs to two standard data
blocks.
You can find additional information on this in section 5.13 of the Programming Guidelines
under: https://support.industry.siemens.com (https://support.industry.siemens.com/cs/
document/81318674/programming-guideline-and-programming-styleguide-for-s7-1200-ands7-1500?dti=0&lc=en-WW)

Compare offline/online
Corrections to internal project data have been made in the current version in order to enhance
data integrity. After installation, this enables individual blocks to be corrected automatically
upon opening, which is why the offline/online comparison displays different checksums.

Online/offline differences in the project tree (S7-1200 FW V2.0 and V2.1)
If you use the "WRIT_DBL" instruction to change a data block, the resulting difference between
online and offline block is initially not displayed correctly by the symbols in the project tree.
The difference is only shown when you terminate an online connection and then go back online.

2.4.2

Notes on instructions

Contents
Information that could not be included in the online help and important information about
product characteristics.

Instruction "TSEND_C: Establishing a connection and sending data" for S7-1200 and S7-1500 CPUs
Contrary to the information in the online help, the value 7002 of the "STATUS" parameter has
the following meaning:
● STATUS=7002: Connection is currently being established (REQ irrelevant)

Instruction "TRCV_C: Establishing a connection and receiving data" for S7-1200 and S7-1500 CPUs
Contrary to the information in the online help, the value 7002 of the "STATUS" parameter has
the following meaning:
● STATUS=7002: Connection is currently being established (REQ irrelevant)
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Instruction "GetSMCinfo: Read information about the SIMATIC memory card"
In addition to the values described in the online help, the "Status" parameter can also have
the following value:
● 8091: The selected value of the "Mode" parameter is only permitted for S7-1500-R/H CPUs.

Instruction "RH_CTRL: Influence sequences in R/H systems"
Contrary to the information in the online help, the values 3 and 4 for the "Mode" parameter
have the following meaning:
● Mode=3: Disable execution of SYNCUP
● Mode=4: Enable execution of SYNCUP again

2.4.3

Note on software units

Contents
Information that could not be included in the online help and important information about
product characteristics.

Using software units for shared commissioning (S7-1500)
Note that only blocks can be synchronized with shared commissioning. Relations are ignored
during the synchronization process.

Manual comparison of software units (SIMATIC S7-1500)
When comparing software units manually, the property comparison overview icon does not
always display the correct result. However, the comparison results of the individual source and
target data are correct.

2.4.4

Testing the user program

2.4.4.1

Testing with the watch table

Contents
Information that could not be included in the online help and important information about
product characteristics.
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Multiple access to the same CPU (S7-300/400/1200)
Online access to a CPU (S7-300/400/1200) from a PG/PC is permitted only when a TIA Portal
is open. Multiple access to the same CPU of this family is not permitted and can lead to errors.

Loading data blocks during an active control job
Note
Loading changed data blocks during an active control job can result in unforeseen operating
states. The control job continues to control the specified address, although the address
assignment may have changed in the data block. Complete active control jobs before loading
data blocks.

"Enable peripheral outputs" function
The function "Enable peripheral outputs" in not available for CPUs of the S7-1500 series in
the TIA Portal.
This function can only be executed with an S7-300, S7-400 or S7-1200 CPU in the TIA Portal.

Testing programs converted from older STEP 7 versions
To monitor and test a program converted from an older STEP 7 version, you first need to
compile and download the program with the current STEP 7 version.

Changed display formats in the watch table
The number of display formats has been reduced so that display formats that are used but no
longer supported are reset to the defaults during a project upgrade.
Example: Pointers can now only be shown in "Pointer" or "Hexadecimal" format.

2.4.4.2

Testing with the force table

Contents
Information that could not be included in the online help and important information about
product characteristics.

Forcing tags for direct I/O access (S7-300)
If you use direct I/O access for an S7-300 CPU in your user program, forcing this I/O address
is not permitted.
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Example
If I/O access to the address "IB0:P" takes place in the user program, it is not permitted to force
the following I/O address areas: I0.0:P, IB0:P, IW0:P and ID0:P.

Changed display formats in the force table
The number of display formats has been reduced so that display formats that are used but no
longer supported are reset to the defaults during a project upgrade.
Example: Pointers can now only be shown in "Pointer" or "Hexadecimal" format.

2.4.5

Compatibility of PLC programs from older versions

2.4.5.1

Compatibility of PLC programs from versions prior to V15.1

Contents
Information that could not be included in the online help and important information about
product characteristics.

Compatibility
Basically, you can continue to use all PLC programs that were created with older versions of
TIA Portal in V15.1. However, because improvements were made to the compiler and errors
corrected there in V15.1, in rare cases the program may react differently after the upgrade or
you may have to adapt the program code manually. These cases are described in detail below.

Processing sequence of function calls in SCL (S7-1200/S7-1500)
In older versions of the TIA Portal, the processing sequence of assignments containing
expressions or function calls was not always clear. Processing was not carried out consistently
from right to left; rather, in certain cases, parts of the expression on the left side were evaluated
first.
This behavior was corrected in V15.1 so that the right side of the assignment is always
calculated first and then the left side is determined.
Example:
#myArr["FC_1"()]:= #x + #y;
In earlier versions, the "FC1" was run here first in order to determine an ARRAY element. Then,
#x + #y was calculated.
As of V15.1, the program is now correctly processed from right to left: First, #x + #y is calculated
and then "FC1" is run.
This correction can have the result that your program behaves differently after upgrade, e.g.
when the tags #x or #y are set in "FC1". Therefore, please check your program after upgrading.
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Comparators (SCL S7-1200 >= 4.2 and S7-1500 >= 2.0)
When comparing two instance data blocks via comparison instructions in SCL, not the structure
of the blocks but only the block numbers are compared. As of V15.1, an error message during
compiling notifies you that this instruction may not return the desired result (FALSE is generally
returned because the numbers of the blocks are different).
Example:
The result of the following comparison instruction is FALSE even if the structure of the two
blocks is identical.
IF "MyDBofFB" = "MyDBofSameFB" THEN …

Importing IEC timers (S7-1200/S7-1500)
IEC timers contain read-only parameters, e.g. ET (current time value). In older versions of the
TIA Portal, the start values of these read-only parameters were overwritten in some cases
when external source files were imported. This behavior was corrected with V15.1: Start values
for read-only parameters are now ignored when source files are imported. Instead, the default
values of the data type are used. Therefore, please check your program after an import.

Replacing invalid Unicode characters during upgrade
Invalid Unicode characters in your program are corrected when upgrading to V15.1. For
example, invalid characters in string constants are replaced with the escape sequences
defined by IEC. This can change the checksum of the program and indicate differences
between the online and offline program. Compile your program and reload it in this case.

Instructions "SCATTER" / "SCATTER_BLK" and "GATHER" / "GATHER_BLK" (SIMATIC
S7-1200/1500)
You can use the "SCATTER" / "SCATTER_BLK" instructions to parse the bit sequence into
individual bits. You can use the "GATHER" / "GATHER_BLK" instructions to combine individual
bits into a bit string.
The values with which the instructions work must not be in the I/O area or in the DB of a
technology object, since data consistency cannot be guaranteed in these areas.
As of V15.1, this rule undergoes a more precise syntax check. If you have the above-mentioned
instructions with invalid input parameters in your program, an error is now reported during
compiling.
As a remedy, you can first copy the tags to a temporary memory area and transfer them from
there to "SCATTER" or "GATHER" instructions.

Instructions "BLKMOV" / "UBLKMOV" and "FILL" / "UFILL"
Use the "BLKMOV" / "UBLKMOV" and "FILL" / "UFILL" instructions to copy the contents of a
memory area (source range) to another memory space (target range). If these instructions
access a memory area that does not exist, a programming error is output. In previous versions,
in rare cases an error code was generated at the "RET_VAL" parameter instead of a
programming error. This behavior has been corrected for S7-1500 CPUs as of firmware version
2.6.

Readme
Programming and Operating Manual, 10/2018

39

STEP 7
2.4 Programming a PLC

"RUNTIME" instruction (SCL/STL S7-1200/S7-1500)
The "Mem" parameter of the "RUNTIME" instruction has the data type "LREAL" and can only
be used with a tag of this data type. Implicit conversion is not possible here. In V15.1, this rule
undergoes a more precise syntax check. If you have provided the "Mem" parameter of the
"RUNTIME" instruction with an invalid data type in your program, an error is now reported
during compiling.

2.4.5.2

Compatibility of PLC programs from versions prior to V15

Contents
Information that could not be included in the online help and important information about
product characteristics.

Compatibility
In principle, you can continue to use in V15 all PLC programs that were created with older
versions of TIA Portal. However, because improvements were made to the compiler and errors
corrected there in V15, it can occur in rare cases that the program reacts differently after the
upgrade or that you have to adjust the program code manually. These cases are described in
detail below.

S7-GRAPH: Implicit conversions "Hardware data type <> INT"
As of TIA Portal V15 it is no longer possible to program implicit conversions of hardware data
types (for example INT -> DB_ANY or DB_ANY -> INT), as is already the case in LAD, FBD,
STL and SCL.
Please use either the UINT data type or an explicit conversion instead.

Subcategories in ProDiag (S7-1500)
From TIA Portal V14 SP1 update 2 the individual subcategories for ProDiag are no longer
added manually, but activated or deactivated in the "Activation" column.
This results in the fact that following the upgrade of a project <V14 SP1 Update 2, which uses
already existing subcategories in at least one monitoring, the "Repair" button must first be
selected before you can create new subcategories.

Instructions "(U)MOVE_BLK" and "(U)FILL_BLK" (S7-1500)
The instructions "(U)MOVE_BLK" and "(U)FILL_BLK" only accessed the process image in TIA
Portal <= V15 when directly accessing the I/O.
This behavior has been corrected and now causes a runtime error because direct I/O access
is not permitted for BLK instructions.

40

Readme
Programming and Operating Manual, 10/2018

STEP 7
2.4 Programming a PLC

Program loops in SCL (S7-1200/S7-1500)
In S7-1200/S7-1500 it is not possible to change the index of a program loop from within the
loop with SCL.
The following program example would therefore be invalid:
FOR #i := 1 TO 10 DO
#i := #i + 1;
END_FOR;
As of TIA Portal V15, a more exact syntax check is conducted in this regard during compilation
and a compilation error is output.

Return values for functions in SCL
The behavior for functions whose return values have a structured data type has been adjusted.
Structured data types are e.g. PLC data types or STRING.
Regardless of whether or not the ENO output uses the function, until now, it could happen that
a temporary working copy of the function value was created although no working copy was
created by the same call without ENO. The assignment of these temporary copies to the
interconnected tag is made when the function is exited.
This behavior was changed as follows:
Using the output parameter ENO now no longer has any influence on whether the return value
is transferred with a copy or with a reference. If the return value has a structured data type, it
is generally transferred as a reference. The transfer rules are described in detail in the section
"Transfer parameter as copy or as pointer".

LDT_TO_DATE in SCL (S7-1500)
The reaction of LDT_TO_DATE to a conversion error in runtime was corrected.

Comparison of an ARRAY element with a variable of the data type "VARIANT" in SCL (S7-1200/1500)
In the past the comparison of a variably indexed ARRAY element with a VARIANT was not
carried out correctly in some cases. Instead of the ARRAY element the complete ARRAY was
used for the comparison.
This behavior has been corrected in V15: The indexed ARRAY element is now evaluated for
the comparison. If you use such comparisons in your program, you have to check the
respective block after upgrading.
Example:
IF (#my_Array[#1] = #my_variant) THEN…
In the past "my_variant" was compared with "my_Array". As of V15 the comparison is carried
out correctly and "my_variant" is compared with Element #1 of "my_Array".

Readme
Programming and Operating Manual, 10/2018

41

STEP 7
2.4 Programming a PLC

Instruction "GetSymbolPath" (S7-1200/S7-1500)
If an FB interconnects a static variable to a formal parameter of a call and a nested block uses
"GetSymbolPath" V1.0 or V1.1 for the parameter, compiling this block results in an additional
display of the DB name before the name of the static variable, however, without a period as a
delimiter and without replacement of the #. Version V1.2 of "GetSymbolPath" shows the path
correctly with a period as a delimiter and without #.
If you use the "GetSymbolPath" instruction in your program, you should use the
"GetSymbolPath" V1.2 instruction after upgrading to >=V15.

Instruction "GetInstancePath" (S7-1200/S7-1500)
If an FB interconnects a static variable to a formal parameter of a call and a nested block uses
"GetInstancePath", compiling this block results in an additional display of the DB name before
the name of the static variable.

Additions and subtractions with DTL/LDT/DT
In additions and subtractions with the data types DTL/LDT/DT, non-typed constants can no
longer be used. A syntax error is signaled.
The following arithmetic operations, for example, are no longer possible:
#myDTL + 1
#myLDT + 1
#myDate_And_Time +1
Use constants of the data type "Time" or "LTime" instead
#myDTL + TIME#1d
#myLDT + TIME#1ms
#myDate_And_Time + LTIME#1ns

Runtime information (S7-1200/S7-1500)
The extended instructions "GetInstanceName", "GetInstancePath", "GetSymbolName",
"GetSymbolPath" and "GetBlockName" now behave in the same way in all programming
languages: If the character string to be output does not fit in the output parameter on account
of size restrictions, the name is truncated and the character "..." is displayed at the end of the
character string.

ARRAYs of multi-instances
In the past ARRAYs of multi-instances could not be addressed correctly when variables were
used to address the index of a multi-instance that was in turn instantiated in a further multiinstance, that in turn was an element of an ARRAY of multi-instance.
Example:
#MyMultiArray[#index].MyMultiMember := 10;
This behavior has been corrected in V15:
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If you have used such accesses in your program, you may have to check the affected block
after upgrading and possibly recompile it.

Block parameters of the data type "VARIANT" (S7-1200/1500)
As is already the case in LAD, FBD, STL and GRAPH, it is now no longer possible either in
SCL to assign and instance DB as the actual parameter to a formal parameter of the data type
"VARIANT".
An exception is formed by instance DBs that are derived from a PLC data type or a system
data type. You assign these to a block parameter of the data type "VARIANT" in all
programming languages.
It is no longer possible to assign a write-protected tag for a block parameter of the data type
"VARIANT" as an actual parameter.
If possible, remove the write protection of the variable. If this is not possible, check how you
can change your program to prevent access to the write-protected variable. If you only want
to have read access, for example, you can copy the content of the write-protected variable in
the calling block into a different variable without write protection. Subsequently you can hand
over this variable as an actual parameter.

Importing external sources
When importing an external source in which an instruction is used as a multi- or single-instance,
the entire program was changed to the instruction version used in the source in the past. As
of Version V15 of TIA Portal this behavior has been corrected: The instructions already
contained in the project are no longer changed over, but rather retain the instruction version
configured by you.
If the project contains different versions of an instruction after the import, a syntax error is
reported. In this case compile the complete project again. To do so, select the "Program blocks"
folder in the project tree and select the command "Compile > Software (only changes)" or
"Compile > Software (compile all)" from the shortcut menu.

Size of ARRAY of BOOL/BYTE/CHAR (S7-1500)
In the past ARRAYS of the data types BOOL, BYTE or CHAR had different sizes depending
on whether they were used within a structure or not. As of V15 the size of the ARRAYs has
been standardized. If you access absolutely in your program, for example by using an ANY
pointer to an ARRAY of the type of BOOL, BYTE or CHAR, you have to check the program
after upgrading.

2.4.5.3

Compatibility of PLC programs from versions prior to V14 SP1

Contents
Information that could not be included in the online help and important information about
product characteristics.
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Compatibility
In V14 SP1 you can generally continue to use all programs that were created with older
versions of TIA Portal. However, because improvements were made to the compiler and errors
corrected there in V14 SP1, it can occur in rare cases that the program reacts differently after
the upgrade or that you have to adjust the program code manually. These cases are described
in detail below.
In addition, you have the option of editing the project in compatibility mode. You can find
additional information on the compatibility under "Compatibility of projects".

Total size of the associated values for program messages
The alarm procedure of the S7-1500 CPU allows a maximum of 512 bytes for associated
values (SD parameters) of the instruction "Program_Alarm".
You will only see a warning regarding this number in TIA Portal <= V14 during compilation.
There is a stricter check as of TIA Portal V14 SP1. If this number is exceeded, an error is output
during compilation to rule out error scenarios during runtime. This check from now on no longer
refers to the actual size of the SD parameters at the time the instruction "Program_Alarm" is
called, but to the maximum possible size of the SD parameters. This means you must decide
beforehand with what length you declare the character string tags you are transferring, as
these take up a large number of bytes.
This must be taken into account in the migration of projects from version <= V14 to version
V14 SP1 Update 1.

Program loops in SCL (S7-1200/S7-1500)
In S7-1200/S7-1500 it is not possible to change the index of a program loop from within the
loop with SCL.
The following program example would therefore be invalid:
FOR #i := 1 TO 10 DO
#i := #i + 1;
END_FOR;
As of TIA Portal V14.0.1, a more exact syntax check is conducted in this regard during
compilation and a compilation error is output.

CASE statements in SCL
Labels without associated "GOTO" instruction are no longer permitted in a CASE statement.
A syntax error is signaled.

ARRAYs of multi-instances
In some cases ARRAYs of multi-instances could not be correctly be addressed in V14 when
individual tags within a multi-instance had the retentivity setting "Set in IDB". This behavior
has been corrected in V14 SP1.
If you have used such tags in your program, you may have to recompile the affected block
after upgrading.
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Parameter type "Block_DB" for entry of the instance DB
In LAD and FBD, you cannot enter the instance DB of an instruction using an input of the data
type "BLOCK_DB". This behavior has been made uniform for all CPU families and all block
types.
As of TIA Portal V14 SP1, a syntax error is output.
If you have transferred instance DBs in your program with the help of the "Block_DB" data
type, you change your program. Instead use a parameter instance to transfer the instance
during runtime.

I/O accesses as input parameters of blocks (S7-1500 as of FW V2.1)
In the event of an I/O access error, direct I/O accesses which are interconnected as input
parameters to blocks no longer result in the block being run through. Instead of this, the system
uses the replacement value of the signal in the block.
For CPUs S7-1500 with FW smaller than V2.1 and all CPUs S7-1200, system behavior is
unchanged:
The block is not called as a result of the I/O access error. Program execution is continued after
the block call. If OB 122 exists or local error handling is enabled, these are executed.

2.4.5.4

Compatibility of PLC programs from versions prior to V14

Contents
Information that could not be included in the online help and important information about
product characteristics.

Compatibility
In principle, you can continue to use in V14 all PLC programs that were created with older
versions of TIA Portal. However, because improvements were made to the compiler and errors
corrected there in V14, it can occur in rare cases that the program reacts differently after the
upgrade or that you have to adjust the program code manually. These cases are described in
detail below.

STL: Instructions "SRW", "SLW" and "SSI" (S7-300, S7-400, S7-1500)
The permitted value range of the offset number of these instructions has changed in TIA Portal
V14 from TIA Portal V13 SP1.
In version V13 SP1, it is possible to specify a number in the range 0 to 31 as an offset number
on a CPU of the S7-1200/1500 series and a number in the range 0 to 15 as an offset number
on a CPU of the S7-300/400 series.
As of Version V14, the value ranges for all CPU series (S7-300/400/1200/1500) was set to the
uniform value from 0 to 15.
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Representation of the BCD format
The representation of the BCD format has changed in regard to the sign from TIA Portal V13
SP1 to TIA Portal V14.
The values in BCD format are show without signs in version V13 SP1.
As of version V14, the values in BCD format are show with sign. This can lead to an altered
representation of the values in BCD format.
Integers (decimal system) Hexadecimal
numbers

Representation in V13
SP1

Representation in V14

0

16#0000

BCD#0

BCD#0

-26215

16#9999

BCD#9999

BCD#-999

1365

16#0555

BCD#555

BCD#555

21845

16#5555

BCD#5555

BCD#555

4096

16#1000

BCD#1000

BCD#0

-28672

16#9000

BCD#9000

BCD#0

Instructions "SET_BF: Set bit field" and "RESET_BF: Reset bit array" (S7-1200, S7-1500)
The response of the instruction in regard to the structures has changed from TIA Portal V13
SP1 to TIA Portal V14.
In version V13 SP1, the number of bits that set or reset are always indicated at the input. This
also applies, for example, if you have specified a structure of data type of the STRUCT or
ARRAY PLC data type. If you want, for example, you want set or reset 10 bits and the structure
contains only 5 bits, then the following 5 bits within the address sequence is also set or reset.
With structures of the type PLC data type, as of version V14 STRUCT or ARRAY the number
of bits contained in the structure represents the maximum number of bits that can be reset: If
you specify the value "20", for example, and the structure only contains 10 bits, only these 10
bits are set. If you specify the value "5", for example, and the structure contains 10 bits, then
exactly 5 bits are set.

Instructions "SCALE: Scale" and "UNSCALE: Unscale" (S7-1500)
The response of the instruction has changed from TIA Portal V13 SP1 to TIA Portal V14 in
regard to specifying the limits (LO_LIM> HI_LIM).
In version V13 SP1, you received an error message when the low limit was greater than the
high limit.
As of version V14, this value is allowed and the result is inversely proportional to the input
value.
On CPUs of the S7-300/400 series, the instruction has always scaled the result inversely
proportional to the input value.

Unused bits of PLC data types (UDT) with firmware >= V1.8.1
The unused bits of PLC data types in standard memory areas are occupied or overwritten, for
example, for a PLC data type that contains 4 bits.
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With firmware versions < V1.8.1, you could not use the unused bits of a PLC data type
elsewhere.
With firmware version >= V1.8.1, all bits are occupied or overwritten even if only 4 bits are
used.
Note
Address assignments
Ensure you do not assign the same absolute address twice to different symbolic address
assignments.

Explicit data type conversion in SCL (S7-1200) with firmware >= V4.2
With firmware versions < V4.2, the string was transferred aligned to the right and filled with
leading spaces during explicit data type conversion of SINT/INT/DINT/REAL_TO_STRING/
WSTRING in SCL.
Example: REAL_TO_WSTRING(12) = ' 1.200000E+1'
As of TIA Portal V13, the string is displayed with a leading sign during explicit data type
conversion of SINT/INT/DINT/REAL_TO_STRING/WSTRING in SCL and transferred aligned
to the left.
Example: REAL_TO_WSTRING(12) = '+1.200000E+1'

SCL: EN/ENO mechanism with block parameters of data type (W)STRING (S7-1200/1500)
As of TIA Portal V14, it is checked whether block parameters of data type (W)STRING are
truncated when parameters are transferred during runtime. This can occur if formal and actual
parameters have different declared lengths. If the declared length of the target parameter
during runtime is insufficient to accept the (W)STRING, the (W)STRING is truncated and the
enable output ENO is set to "FALSE".
If you evaluate the enable output ENO in your program, the semantics of your program may
change.

Forwarding STRING parameters between optimized blocks and standard blocks (S7-1200/1500)
Prior to TIA Portal V14, no length information about STRINGs was transferred when
parameters were transferred between optimized and non-optimized blocks. This meant that
access errors not detected by the ENO mechanism could occur during the further processing
of the STRING. The enable output ENO remained at TRUE despite an access error.
As of TIA Portal V14, the STRING length information is transferred and access errors are
monitored by the ENO mechanism. If you evaluate the enable output ENO in your program,
the semantics of your program may change.
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Length declaration for constants of the "STRING" or "WSTRING" data type
Length declarations are no longer permitted for local and global (W)STRING constants. If your
program includes length declarations, for example, "MyStringConst [7]", these are
automatically removed during the upgrade. This change has no semantic effect on your
program, however.

Changing the base data type for HW_ANY from WORD to UINT
The hardware data type "HW_ANY" is used to identify any hardware component, such as a
module. In V14, the base data type of "HW_ANY" was changed from WORD to UINT. After
the conversion to V14, compiling errors can therefore occur if you have assigned an explicit
WORD constant (such as W#16#1) or a tag of data type WORD at a parameter of data type
"HW_ANY".
In this case, change the notation of the constant (e.g. to 16#1) or change the data type of the
tag to UINT.

Length of block comments
As of TIA Portal V14, the block comments must not exceed a length of 32767 Unicode
characters.

Syntax check of the instructions "SR: Set/reset flip-flop" and "RS: Reset/set flip-flop"
Inputs, outputs, bit memories as well as static or local data can be used as operands at the
"S" input. Use of constants is not permitted. So far, the use of the constants "0" and "1" was
not rejected by the syntax check. As of TIA Portal V14 the syntax check was improved so that
the use of "0" or "1" is now rejected at the "S" input. You may now receive an error message
during the compiling of a program that has been compiled without errors up to this point.
Change your program in this case and use a permitted operand.

Any pointer: Access to optimized data
For a CPU of the S7-1500 series, the ANY pointer can also only point to memory areas with
"Standard" access mode. Access to optimized data is not permitted with an ANY pointer.
A more detailed syntax check of ANY pointers is performed as of TIA Portal V14. Access to
optimized data is now rejected. You may now receive an error message during the compiling
of a program that has been compiled without errors up to this point.

"(L)REAL" data type
With 64-bit Windows versions, the LREAL data type is sometimes evaluated differently than
with the previous 32-bit versions of Windows. A difference may occur when rounding and (L)
real values of constants in the least significant bit.
The potential difference is in the last digit of the mantissa and in most cases therefore only
has a slight effect on the accuracy.
If you evaluate the last digit of the mantissa, the semantics of your STEP 7 program may
change after the conversion.
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"ST" parameter for IEC timers
The "ST" parameter of an IEC timer is used internally and it is prohibited to write it. This why
this parameter is no longer visible as of TIA Portal V14. If you have write access in your program
to the "ST" parameter, an error message is generated during compiling after the upgrade.
If you exchange data with Inter Project Engineering and you have access to the "ST" parameter
with HMI, you must first export the project and then re-import it into the proxy CPU. Only then
does the "ST" parameter disappear in the HMI configuration.

Associated values for messages (S7-1500)
Projects created with an older version of the TIA Portal can contain embedded associated
values with different structures in the different project languages. The associated values may
have a different order or may be missing in a different language. When a project of this type
is upgraded, the order of the associated values is harmonized. It is based on the reference
language set in the original project. In this case, it is recommended to have the translated texts
checked and corrected.

Implicit data type conversion for block parameters of the "DB_ANY" data type
When accessing a block parameter of the "DB_ANY" data type with the syntax DB_ANY.
%DB(B|W|D), no implicit data type conversion was performed previously. The bit pattern of
the source value was simply converted into the target data type. If the target data type was
smaller than the source data type, an overflow occurred and the written value may have been
wrong or inaccurate. The enable output ENO is not set to "FALSE" when accuracy is lost or
runtime errors occur.
As of V14, conversion is performed according to the rules of implicit data type conversion when
parameters are passed with the syntax DB_ANY.%DB(B|W|D). Note that after the upgrade a
different value may be written and the semantics of your program may change. In addition, the
enable output ENO is set to "FALSE" when a runtime error occurs.

Interface of organization blocks with standard access
The interface of organization blocks with standard access must have a minimum size of 20
bytes. In older versions of TIA Portal, only the interface of OB1 was checked with regard to
the minimum size during the compilation run. As of V14, interfaces of all organization blocks
are checked. You may now receive an error message during the compiling of a program that
has been compiled without errors up to this point.

Comparing tags of WORD data type to tags of the S5TIME data type (S7-1500)
As of TIA Portal V14, both variables are converted to the TIME data type when comparing a
variable of WORD data type to a variable of S5TIME data type. The WORD tag is interpreted
as an S5TIME value. If one of the variables cannot be converted, the comparison is not
performed and the result is FALSE. After successful conversion, the comparison is performed
based on the selected comparison expression.
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2.4.5.5

Compatibility of PLC programs from versions prior to V13 SP1

Content
Information that could not be included in the online help and important information about
product characteristics.

Compatibility
You can continue to use in V13 SP1 all programs that were created with TIA Portal V12 SP1
or V13. However, because improvements were made to the compiler and errors corrected
there (compilation of the program code) in V13 SP1, it can occur in rare cases that the program
reacts differently after the upgrade or that you have to adjust the program code manually.
These cases are described in detail below.

Unused bits of PLC data types (UDT) with firmware >= V1.8.1
The unused bits of PLC data types in standard memory areas are occupied or overwritten, for
example, for a PLC data type that contains 4 bits.
With firmware versions < V1.8.1, you could not use the unused bits of a PLC data type
elsewhere.
With firmware version >= V1.8.1, all bits are occupied or overwritten even if only 4 bits are
used.
Note
Address assignments
Ensure you do not assign the same absolute address twice to different symbolic address
assignments.

Explicit data type conversion in SCL (S7-1200) with firmware >= V4.2
With firmware versions < V4.2, the string was transferred aligned to the right and filled with
leading spaces during explicit data type conversion of SINT/INT/DINT/REAL_TO_STRING/
WSTRING in SCL.
Example: REAL_TO_WSTRING(12) = ' 1.200000E+1'
As of TIA Portal V13, the string is displayed with a leading sign during explicit data type
conversion of SINT/INT/DINT/REAL_TO_STRING/WSTRING in SCL and transferred aligned
to the left.
Example: REAL_TO_WSTRING(12) = '+1.200000E+1'
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Reading an invalid peripheral input
In the TIA Portal as of version 12, the error code 16#2942 for the reading of an invalid peripheral
input is only output if you have programmed the faulty access in such a way that this becomes
effective, for example %MW10 := “InvalidWordAccess":P, and does not lie within an irrelevant
sequence. For example, this would be #tmp := “InvalidWordAccess":P, if the tag #tmp is not
used in the rest of the program block.

Instruction "S_CONV: Convert character string"
The EN/ENO mechanism behaves differently in TIA Portal V13 SP1 than in TIA Portal V13.
In version V13, the ENO enable output returns the signal state "0" in case of error, even if you
have deactivated the ENO enable output. If you have switched an additional instruction to the
ENO enable output, this is then not executed.
In version V13 SP1, the ENO enable output returns the signal state "1" in case of error, if you
have deactivated the ENO enable output. If you have switched an additional instruction to the
ENO enable output, this is then executed as expected.

Instruction "SET: Set bit array" (S7-300/S7-400)
In the TIA Portal, you can also interconnect an element of a data block at the N parameter of
the SET instruction.

Instruction "MUX: Multiplex" (SCL)
Up to and including TIA Portal V13, the value of the tag at the input parameter was output
unchanged as a function value, even if the K parameter had a negative integer. This behavior
has changed in TIA Portal V13 SP1.
In TIA Portal V13 SP1, if you use a tag with a valid data type at the input parameters of the
MUX instruction and the K parameter is a negative integer, the value of the tag is changed.
You can find the valid data types in the description of the MUX instruction in the information
system.

Instruction "DEMUX: Demultiplex" (SCL)
Up to and including TIA Portal V13, no value was output at the OUTELSE output parameter if
the value of the K parameter was < 0. In contrast, the value of the IN input parameter was
output at the OUTELSE output parameter if the value of the K parameter was > available
outputs. This behavior has changed in TIA Portal V13 SP1.
In the TIA Portal V13 SP1, if you specify at the K parameter a value that is outside the available
outputs (K < 0 or K > available outputs), then the value of the IN input parameter is output at
the OUTELSE output parameter.

Instruction "MOVE: Move value" (STL) (S7-1500)
As of the TIA Portal V13 SP1, a stricter syntax rule applies to the "MOVE" instruction in STL:
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Up to and including TIA Portal V13. it was possible to specify non-typed constants, such as
"0" at the input parameter IN.
If you want to copy, for example, the value "0" in the TIA Portal V13 SP1, you need to specify
a typed constant according to the data type of the output parameter (e.g. INT#0, DINT#0, etc.).

Instruction "Program_Alarm: Generate program alarm with associated values" (S7-1500)
As of TIA Portal V13 SP1 the data type INT is no longer permitted for use for the associated
values or an index tag of a text list. Use the UINT data type instead.

Instructions "READ_DBL: Read from data block in the load memory" and "WRIT_DBL: Write to data
block in the load memory"
TIA Portal V13 SP1 reports a compilation error if you use "READ_DBL" V1.0 or "WRIT_DBL"
V1.0 and access a data block with the attribute "Only store in load memory" using the parameter
DSTBLK.
Instead, use version 1.2 of both instructions.

"READ_DBL instructions: Read from data block in the load memory" and "WRIT_DBL: Write to data
block in the load memory" (SCL)
As of TIA Portal V13 SP1, the "READ_DBL" and "WRIT_DBL" instruction in SCL are subject
to the same strict syntax rules as all other programming languages:
In TIA Portal V13, it was possible to specify "standard" data blocks at the SRCBLK and
DSTBLK parameters that contained tags with different data types.
As of TIA Portal V13 SP1, the individual tags contained must have the same data type for both
"standard" as well as for "optimized" data blocks; otherwise, compiling errors are reported.

Function values (Return)
As of TIA Portal V13 SP1, more stringent syntax rules apply to function call:
It is checked that the function value (Return) is written in any case, even if multiple possible
program paths can be run through in the function. Therefore, there is no longer any risk that
the function values will accidentally not be written during runtime.
However, you may possibly receive syntax errors in functions during compiling, which it was
still possible to compile without errors in V13. In such cases change the program code so that
the function valve is written in all possible program paths.
Example:
SCL
IF #MyIn1 = #MyIn2 THEN
#Block_3 := #MyIn1 + 1;
END_IF;
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In this example, the function value of "Block_3" is not written if the condition of the IF instruction
is not fulfilled. The function value then contains an undefined value.
SCL
#Block_3 := #MyIn1;
IF #MyIn1 = #MyIn2 THEN
#Block_3 := #MyIn1 + 1;
END_IF;

In this example the function valve of "Block_3" is definitely written in the program, since "MyIn1"
is set as default before the IF loop is completed.

Comparing the hardware data types HW_IO and HW_DEVICE
As of TIA Portal V13 SP1, there is a stricter syntax rule that is valid for the comparison of the
data types HW_IO and HW_DEVICE:
Up until and including TIA Portal V13 it was possible to compare the data types HW_IO and
HW_DEVICE directly with each other.
If you want to compare these data types in TIA Portal V13 SP1 you have to first create a tag
of the data type HW_ANY in the section "Temp" for the block interface and then copy the
LADDR (from data type HW_DEVICE) to the tag. It is then possible to compare HW_ANY and
HW_IO.

Implicit conversion of floating-point numbers to DWORD (GRAPH) (S7-1500)
As of TIA Portal V13 SP1 stricter syntax rules apply for the implicit conversion of floating-point
numbers to DWORD:
Up to and including TIA Portal V13, it was possible to convert a non-typed constant (e.g. 1.0)
implicitly to the data type DWORD if the value was less than 32 bits.
With TIA Portal V13 SP1, if you want to convert a floating-point number implicitly to the data
type DWORD, you can only use typed constants (e.g. REAL#1.0) since a non-typed constant
(e.g. 1.0) is interpreted as data type LREAL and can no longer be converted implicitly to
DWORD.

Assigning a value to a LTIME constant (S7-1500)
As of the TIA Portal V13 SP1, a stricter syntax rule applies to the definition of a value to a
LTIME constant:
Up until and including TIA Portal V13 it was possible to assign a TIME value (e.g. T#10s) to a
LTIME constant.
If you want to assign a value to a LTIME constant in TIA Portal V13 SP1, you have to use
LTIME syntax (e.g. LT#10s).
Please note that the corresponding TIA Portal projects from previous versions already had to
have been adjusted before the upgrade to TIA Portal V13 SP1.
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Indirect indexing of ARRAY components of data type bit string in SCL (S7-1200/S7-1500)
In TIA Portal V13, you can address the components of an ARRAY for a CPU of the
S7-1200/1500 series in SCL with a tag of the data type BYTE, WORD, DWORD or LWORD
as index in addition to a tag of the integer data type if the IEC check is not set. This is not
possible for a CPU of the S7-300/400 series.
The result is an incompatibility with TIA Portal V12 SP1 in which indirect indexing with the data
type bit string is also permitted on a CPU of the S7-300/400 series.

EN/ENO mechanism for STRING conversion (S7-1200/S7-1500)
Conversion

Description

Strg_TO_Chars: Convert character string to Array
of CHAR

The ENO enable output returns the signal state "0"
even if you have deactivated the ENO enable out‐
put:
● For an invalid character at the CHARS
parameter
● For an invalid ARRAY index at the PCHARS
parameter
● If the sum of the PCHARS and STRG
parameters exceeds the length of the target
ARRAY.

Chars_TO_Strg: Convert Array of CHAR to char‐
acter string

The ENO enable output returns the signal state "0"
even if you have deactivated the ENO enable out‐
put:
● If the sum of the PCHARS and CNT
parameters exceeds the length of the source
ARRAY.

Overflow of the local data stack (S7-300/S7-400)
As of TIA Portal V13 SP1, the size of the local data stack is checked to ensure it does not
exceed what you have defined for the OB priorities in the hardware configuration.
This means that you may get error messages during compilation in projects that could be
compiled without errors in V13. If this happens, change the maximum size of the local data
stack in the hardware configuration.
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2.5

Inter Project Engineering (IPE)

2.5.1

Notes on IPE

Contents
Information that could not be included in the online help and important information about
product characteristics.

Using system diagnostics in the device proxy
To use the "system diagnostics" function in an IPE device proxy, for example, a system
diagnostics view, insert the PLC alarms as content of a device proxy.

Connections to the SIMATIC S7-1500 software controller
Connections to the SIMATIC S7-1500 software controller as device proxy are only possible
via the interfaces assigned to the software PLC.

Support of Alarm_S alarms
The integrated configuration with WinCC and SIMATIC Manager support the Alarm_S alarms,
which are available via data blocks and Continuous Function Chart (CFC).

Compatibility
With TIA Portal V15.1, you can open the IPE files of the same version and earlier versions
from V13 SP1.
IPE files created with TIA Portal version V15.1 cannot be opened with earlier versions.

2.6

Technological functions

2.6.1

Notes on S7-1500 Motion Control (S7-1500)

Exception error when fixed stop detection is activated with MC_TorqueLimiting
When you start an "MC_TorqueLimiting" job with parameter "Mode" = 1 and the technology
object is not enabled, an exception error may occur in the execution system of the CPU. Make
sure that the technology object is enabled (MC_Power.Status = TRUE) before you start an
"MC_TorqueLimiting" job.
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Configuration of TM PosInput 1/TM PosInput 2 for position detection with the technology object
measuring input
● Technology object measuring input
For use with Motion Control and a technology object measuring input, select the measuring
input type "Measuring using PROFIdrive telegram (drive or external encoder)" under
"TO_MeasuringInput > Hardware interface > Input measuring input".
● TM PosInput 1/TM PosInput 2
You set the parameters for the encoder signals of the channel under "Module parameters"
in "Position detection for Motion Control" mode. The parameters must be set depending on
the encoder used.
Note
When a single-turn absolute encoder is used and two edges are to be measured
("MC_MeasuringInput.Mode" = 2, 3 or 4), the distance between the measured edges of the
measurment input must be < 1 encoder revolution. Otherwise, use a multi-turn absolute
encoder.

Display of the geometry of the kinematics type "Cylindrical robot" (S7-1500T)
In contrast to the documented display of the kinematics type "Cylindrical robot", the length L1
represents the distance between the kinematics zero point (KZP) and the bottom edge of the
articulated arm. The flange length LF represents the distance between the bottom edge of the
articulated arm and the flange coordinate system (FCS). This applies both to the "3D" variant
and the "3D with orientation" variant.
The graphic below shows the side view of the kinematics type "Cylindrical robot 3D" (xz plane)
as an example:
● The position of the axes and the coordinate systems KCS and FCS
● The zero positions of the axes A1 and A2
● The deflection of the kinematics is indicated (dashed)
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Zero position of the axes A1 and A2
L1

At zero position of the axis A2:
Distance of the FCS to the kinematics zero point (KZP) and flange length LF in z direction
of the KCS

LF

Flange length before the FCS in the z direction of the FCS

x1

Positive deflection of the axis A3
At the zero position of axis A3, the z axis of the FCS is located on the z axis of the KCS.
For mechanical reasons, the kinematics shown cannot approach the zero position of the
axis A3.

Deflection of the kinematics
x2

Positive deflection of the axis A3

z1

Positive deflection of the axis A2

Interrupt execution of the motion with an "MC_GroupInterrupt" job (S7-1500T)
Contrary to the documented behavior, you can only interrupt the execution of the motion at
the kinematics technology object during an active kinematics motion with an
"MC_GroupInterrupt" job. If the kinematics is already at a standstill, the execution of the motion
is not interrupted for subsequent motion jobs. The kinematics is not in "Interrupted" state
(StatusWord.X17 (Interrupted)).
By entering the value "0.0" for the velocity override, you can suspend the motion until all
requested jobs have been entered in the job chain. Then you can continue the motion with a
velocity override "100.0".
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Effect of the velocity override on kinematics motion jobs (S7-1500T)
If you change the velocity override, different results occur for motion jobs of the kinematics
technology object, in which the orientation motion determines the duration of the overall motion.
This depends on whether you change the velocity override before or after the motion job is
issued.
For motion jobs that are already in the job sequence ("Busy" = TRUE) or being executed
("Active" = TRUE), the kinematics motion is already reduced to the possible orientation velocity.
This means that the change to the velocity override only affects the path velocity.
For motion jobs that are added to the job sequence after the change to the velocity override,
the changed velocity override also affects the orientation velocity.
For this reason, change the value of the velocity override before you issue motion jobs.

Controlling velocity override with the Kinematics control panel (S7-1500T)
Contrary to the behavior described in the documentation, you can use the slider to set the
velocity only in the world coordinate system (WCS) and object coordinate system (OCS).
Kinematics motions in the machine coordinate system (MCS) are executed with the velocity
override (<TO>.Override.Velocity) of the individually interconnected axes.

Executing "MC_GroupStop" following a "MC_GroupInterrupt" (S7-1500T)
If you execute an "MC_GroupStop" job after an "MC_GroupInterrupt" job, you have to leave
the parameter "Execute" at the "MC_GroupStop" set to TRUE until the job sequence is empty
(StatusMotionQueue.NumberOfCommands = 0). If the job sequence is not empty, the
remaining motion jobs in the job sequence are executed.

2.6.2

Notes on additional technology functions (S7-1500)

Parameters of the technology objects in TIA Portal Openness
You can find a list of the available technology object parameters in the product information
"Parameters of the technology objects in TIA Portal Openness" on the internet (https://
support.industry.siemens.com/cs/ww/en/view/109744932).

S_USSI on S7‑1500
Note the following when using the instruction S_USSI of the distributed I/O ET 200S 1SI on
an S7‑1500.
The parameter ANZ shows the value 0 even in the case of an error.
If the CPU is switched to stop with the S_USSI instruction, check all possible errors listed at
the parameter ANZ.
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PtP module with CM 1243-5 PROFIBUS Master
You have to make the following settings in the instance DB of the instructions when using the
PtP modules CM PtP RS232 BA, CM PtP RS422/485 BA, CM PtP RS232 HF, CM PtP
RS422/485 HF and CM PtP with a CM 1243-5 PROFIBUS Master with firmware ≤ V1.3.4:
● Send_P2P
max_record_len = 240
● Modbus_Master
Send_P2P.max_record_len = 240
● Modbus_Slave
Send_P2P.max_record_len = 240

PID_Temp on CPU 1500 V1.7
Note the following when using PID_Temp on a CPU 1500 with firmware version V1.7:
● The integrated dead zone in PID_Temp must not be used on CPU 1500 V1.7.
Do not change the preset 0.0 of the associated parameters
Retain.CtrlParams.Heat.DeadZone and Retain.CtrlParams.Cool.DeadZone.
● If the cooling output is active (PidOutputSum < 0.0, OutputCool <> 0.0) for a closed loop
controller with active cooling and PID parameter switchover (Config.ActivateCooling =
TRUE, Config.AdvancedCooling = TRUE) while "Pretuning cooling" is started (Mode = 1,
Heat.EnableTuning = FALSE, Cool.EnableTuning = TRUE), aborts with error ErrorBits =
16#0040_0000.
– In this case use "Fine tuning cooling" (Mode = 2, Heat.EnableTuning = FALSE,
Cool.EnableTuning = TRUE)
or
– Before starting the pretuning, switch to manual mode with a manual value larger than
0.0 (Mode = 4, ManualValue ≥ 0.0).
As of firmware version V1.8, these two restrictions no longer apply.

2.6.3

Notes on technological functions (S7-1200)

Display errors in the online/offline comparison for S7-1200 Motion Control
If you upgrade a TIA Portal project V15 to V15.1 and establish an online connection to the
CPU on which the project with TIA Portal V15 was loaded, differences in the online/offline
comparison are shown which do not actually exist. This can also be an invalid configuration.
Load the upgraded project to the CPU. The online/offline comparison shows the correct results
once again.

Readme
Programming and Operating Manual, 10/2018

59

STEP 7
2.6 Technological functions

Parameters of the technology objects in TIA Portal Openness
You can find a list of the available technology object parameters in the product information
"Parameters of the technology objects in TIA Portal Openness" on the internet (https://
support.industry.siemens.com/cs/ww/en/view/109744932).

PtP module with CM 1243-5 PROFIBUS Master
You have to make the following settings in the instance DB of the instructions when using the
PtP modules CM PtP RS232 BA, CM PtP RS422/485 BA, CM PtP RS232 HF, CM PtP
RS422/485 HF and CM PtP with a CM 1243-5 PROFIBUS Master with firmware ≤ V1.3.4:
● Send_P2P
max_record_len = 240
● Modbus_Master
Send_P2P.max_record_len = 240
● Modbus_Slave
Send_P2P.max_record_len = 240

2.6.4

Notes on technological functions (S7-300, S7-400)

Parameter assignment for the FM x51 and FM x52
In contrast to the information in the Online Help, if you change the measuring system, the
previously entered parameter values are not converted to the new measuring system.

Programming FM x50-1, FM x51 and FM x52
The "initial values" specified in the parameter tables in the online help regarding the instructions
correspond to the "default value" in the software interface of the user programming.

IM 174 migration
During the migration of projects with IM 174, the parameter assignment of IM 174 is set to
default values. It is absolutely necessary to set parameters for IM 174 again after the migration.

2.6.5

SIMATIC STEP 7 Easy Motion Control

2.6.5.1

Notes on SIMATIC STEP 7 Easy Motion Control
There are no notes available on SIMATIC STEP 7 Easy Motion Control.
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2.6.6

SIMATIC STEP 7 PID Professional

2.6.6.1

Notes on SIMATIC STEP 7 PID Professional
There are no notes available on SIMATIC STEP 7 PID Professional.
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Security information
Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions only form one element of such a concept.
Customer is responsible to prevent unauthorized access to its plants, systems, machines and
networks. Systems, machines and components should only be connected to the enterprise
network or the internet if and to the extent necessary and with appropriate security measures
(e.g. use of firewalls and network segmentation) in place.
Additionally, Siemens’ guidance on appropriate security measures should be taken into
account. For more information about industrial security, please visit
http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)
Siemens’ products and solutions undergo continuous development to make them more secure.
Siemens strongly recommends to apply product updates as soon as available and to always
use the latest product versions. Use of product versions that are no longer supported, and
failure to apply latest updates may increase customer’s exposure to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under
http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)

Passwords
Various passwords are set by default in WinCC. For security reasons, you should change
these passwords.
● For HMI devices with version 12, the default password for the Sm@rtServer and for the
embedded Web server is "100". A default password is not preset for HMI devices with
version V13.
● For the user "Administrator", the default password is "administrator".

Integrated Web server
It is always possible on a PC to access HTML pages in Runtime, even though the option"HTML
pages" is disabled. Setup always installs the standard pages of the Web Server on the PC.
Assign an administrator password to prevent unauthorized access to the pages.
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Communication via Ethernet
In Ethernet-based communication, end users themselves are responsible for the security of
their data network. The proper functioning of the device cannot be guaranteed in all
circumstances; targeted attacks, for example, can lead to overload of the device.

Use of SSL 3.0
For security reasons, the use of the protocol SSL 3.0 is not recommended on Comfort Panels
or in Runtime Advanced. The use of the protocol SSL 3.0 is disabled by default on Comfort
Panels. If you nevertheless wish to activate the use of SSL 3.0, select the following in Internet
Explorer or in "Start Center > Settings: Internet Options > Advanced > Use SSL 3.0".
For RT Advanced, the use of SSL 3.0 can be disabled in Internet Explorer or in the Control
Panel under "Internet Options > Advanced" by deactivating the "Use SSL 3.0" option.

Network settings
The following tables show the network settings of each product which you need in order to
analyze the network security and for the configuration of external firewalls:
WinCC Professional (without simulation)
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

ALM

4410*

TCP

Inbound,
Outbound

License service

This service provides the complete functionali‐
ty for software licenses and is used by both the
Automation License Manager as well as all li‐
cense-related software products.

HMI Load

1033

TCP

Outbound

HMI Load (RT
Basic)

This service is used to transmit images and
configuration data to Basic Panels.

HMI Load

2308

TCP

Outbound

HMI Load
(RT Advanced)

This service is used to transmit images and
configuration data to panels.

RPC

**

UDP

Inbound,
Outbound

Client / server &
ES communica‐
tion (CCAgent)

This service is used by WinCC Professional
and WinCC Runtime Professional.

* Default port that can be changed by user configuration
** Port is assigned automatically

WinCC Simulation for Basic Panels
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

HMI Load

1033

TCP

Inbound

HMI Load
(RT Basic)

This service is used to transmit images and
configuration data to Basic Panels.

EtherNet/IP

44818

TCP

Outbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

2222

UDP

Inbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

502

TCP

Outbound

Modbus TCP
channel

The Modbus TCP protocol is used for connec‐
tions to Schneider PLCs.

Modbus TCP
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WinCC Simulation for Basic Panels
RFC 1006

102

TCP

Outbound

S7 channel

Communication with the S7 controller via
Ethernet/PROFINET

Mitsubishi MC

5002

TCP

Outbound

Mitsubishi MC
channel

The Mitsubishi protocol is used for connections
to Mitsubishi PLCs.

WinCC Simulation for Panels and Runtime Advanced
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

DCP

---

Ethernet

Outbound

PROFINET

The DCP protocol (Discovery and basic Con‐
figuration Protocol) is used by PROFINET and
provides the basic functionality for locating and
configuring PROFINET devices.

LLDP

---

Ethernet

Inbound,
Outbound

PROFINET

The LLDP protocol (Link Layer Discover Proto‐
col) is used by PROFINET for topology detec‐
tion.

SMTP

25

TCP

Outbound

SMTP
Communication

This service is used by WinCC Runtime Ad‐
vanced to send e-mails.

HTTP

80*

TCP

Inbound

Sm@rtServer

The Web server is only available when
Sm@rtService is activated. The used port may
differ depending on automatically selected set‐
tings.

RFC 1006

102

TCP

Outbound

S7 channel

Communication with the S7 controller via
Ethernet/PROFINET

NTP

123

UDP

Outbound

Time synchroni‐
zation

The NTP protocol (Network Time Protocol) is
used for time synchronization in IP-based net‐
works.

SNMP

161

UDP

Outbound

PROFINET

The SNMP client functionality is used by STEP
7 to read status information from PROFINET
devices.

HMI Load

2308

TCP

Outbound

HMI Load
(RT Advanced)

This service is used to transmit images and
configuration data to panels.

HTTPS

443*

TCP

Inbound

Sm@rtServer

The Web server with HTTPS protocol is only
available when Sm@rtService is activated.
The used port may differ depending on auto‐
matically selected settings.

VNC server

5900*

TCP

Inbound

Sm@rtServer

This service is only available when Sm@rtSer‐
vice is activated.

5800*

TCP

Inbound

Sm@rtServer

This service is only available when Sm@rtSer‐
vice is activated.

5500

TCP

Outbound

Sm@rtServer

This service is only available when Sm@rtSer‐
vice is activated.

VNC client

* Default port that can be changed by user configuration
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WinCC Simulation for Runtime Professional
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

RPC

**

UDP

Inbound,
Outbound

Client / server &
ES communica‐
tion (CCAgent)

This service is used by WinCC Professional
and WinCC RT Professional.

RPC

**

UDP

Inbound,
Outbound

Client / server
communication
(CCEServer /
CCEClient)

This service is used by WinCC Runtime Pro‐
fessional.

HTTP

80

TCP

Inbound,
Outbound

Client / server
communication
(CCEServer /
CCEClient)

This service is used by WinCC Runtime Pro‐
fessional.

RFC 1006

102

TCP

Outbound

S7 channel

Communication with the S7 controller via
Ethernet/PROFINET

OPC UA

4840

TCP

Inbound

OPC UA server

This service is required for primary communi‐
cation via OPC UA. It is activated and config‐
ured during installation.

OPC UA discov‐ 52601
ery

TCP

Inbound

OPC UA server

This service provides information about the in‐
stalled OPC server. It is installed and config‐
ured by the OPC UA server.

DCOM

135

TCP

Inbound

OPC server

This service is part of the Windows operating
system. Since communication via OPC (DA) is
based on DCOM, this service is required to in‐
itialize OPC (DA) connections.

DCOM

**

TCP

Inbound

OPC server

The communication via OPC (DA) is based on
DCOM and uses unspecified ports assigned by
the system. This should be taken into consid‐
eration when using OPC (DA) and creating
rules for the firewall.

HTTP

80

TCP

Inbound

OPC server

This service is required for primary communi‐
cation via OPC XML. It is activated and config‐
ured during installation.

NetBIOS

137

UDP

Inbound

OPC server

This service is part of the Windows operating
system. Access to this service is required by
OPC-Scout, for example, for browsing.

NetBIOS

138

UDP

Inbound

OPC server

This service is part of the Windows operating
system. Access to this service is required by
OPC-Scout, for example, for browsing.

SNMP

161

UDP

Outbound

SNMP OPC
server

This service is used by the SNMP OPC server
to change or query data on network drives, for
example.

SNMP Traps

162

UDP

Inbound

SNMP OPC
server

This service is used by the SNMP OPC server
to query events from network drives, for exam‐
ple.

** Port is assigned automatically
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PROFINET protocols for Panels and Runtime Advanced
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

DCP

---

Outbound

Lifelist,
PROFINET Dis‐
covery and con‐
figuration

The DCP protocol (Discovery and basic Con‐
figuration Protocol) is used by PROFINET and
provides the basic functionality for locating and
configuring PROFINET devices.

Ethernet

LLDP

---

Ethernet

Inbound,
Outbound

PROFINET Link
Layer Discovery
protocol

The LLDP protocol (Link Layer Discover Proto‐
col) is used by PROFINET for topology detec‐
tion.

MRP

---

Ethernet

Outbound

PROFINET me‐
dium redundan‐
cy

The MRP protocol (Medium redundancy proto‐
col) enables control of redundant transmission
paths using a ring topology.

PROFINET IO
Data

---

Ethernet

Inbound,
Outbound

PROFINET Cy‐
clic IO data
transfer

Cyclic data exchange is used by panels for di‐
rect keys and LEDs.

NARE

---

Ethernet

Inbound,
Outbound

Name Address
Resolution

This protocol is used to resolve network names
and assign IP addresses.

UDP

Inbound,
Outbound

PROFINET con‐ The PROFINET Context Manager provides an
nection less
endpoint mapper in order to establish an appli‐
RPC
cation relation (PROFINET AR).

PROFINET Con‐ 34964
text Manager

Communication connections for Panels and WinCC Runtime Advanced
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

Telnet

23

TCP

Inbound

Telnet

This service can be used for maintenance.

SMTP

25

TCP

Outbound

SendEMail

This service is used by Windows CE / PC Run‐
time to send e-mails.

HTTP

80*

TCP

Inbound

Hypertext
Transfer Proto‐
col

The HTTP protocol is used for communication
with the internal Web server.

RFC 1006

102

TCP

Outbound

S7 channel

Communication with the S7 controller via
Ethernet/PROFINET.

NTP

123

UDP

Outbound

Time synchroni‐
zation

The NTP protocol (Network Time Protocol) is
used for time synchronization in IP-based net‐
works.

DCOM***

135

TCP

Inbound

OPC server

This service is a component of the Microsoft
Windows operating system. Communication
via OPC (DA) is based on DCOM. This service
is therefore required to initialize OPC (DA) con‐
nections.

DCOM***

**

TCP

Inbound

OPC server

The communication via OPC (DA) is based on
DCOM and uses unspecified ports assigned by
the system. This should be taken into consid‐
eration when using OPC (DA) and creating
rules for the firewall.
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Communication connections for Panels and WinCC Runtime Advanced
NetBIOS over
TCP/IP

137

UDP

Outbound

With the use of
Remote File
Share

Register / log on to a remote server.

NetBIOS over
TCP/IP

138

UDP

Outbound

With the use of
Remote File
Share

Register / log on to a remote server.

SNMP

161

UDP

Outbound

Simple Network
Management
Protocol

The SNMP client functionality is used by STEP
7 to read status information from PROFINET
devices.

HTTPS

443*

TCP

Inbound

Secure Hyper‐
text Transfer
Protocol

The HTTP protocol is used for communication
with the CPU-internal Web server via Secure
Socket Layer (SSL).

Modbus TCP

502*

TCP

Outbound

Modbus TCP
channel

The Modbus TCP protocol is used for connec‐
tions to Schneider PLCs.

Mitsubishi MC

1025*

TCP

Outbound

Mitsubishi MC
channel

The Mitsubishi protocol is used for connections
to Mitsubishi PLCs.

Printing

1032

TCP

Outbound

Printing

Printing on the control panel (via Ethernet).

HMI Load

2308

TCP

Outbound

Transfer

This service is used to transmit images and
configuration data to panels. On Comfort Pan‐
els, this service has been replaced by Device‐
Manager and SCS as of V13. This service is
used to transmit configuration data to WinCC
Runtime Advanced.

HMI Load

50523

TCP

Outbound

Transfer

This port is used if port 2308 is not available.
This service is used to transmit images and
configuration data to panels. On Comfort Pan‐
els, this service has been replaced by Device‐
Manager and SCS as of V13.
This service is used to transmit configuration
data to WinCC Runtime Advanced.

ALM

4410*

TCP

Inbound,
Outbound

Application Li‐
cense Manager

This service of RT Advanced makes available
the complete functionalities for software licen‐
ses and is used by the Automation License
Manager.

OPC UA

4870*

TCP

Inbound

OPC UA server

This service is required for communication via
OPC UA.

HMI Load

5001

TCP

Outbound

Device Manager This service is used to transmit images and
Runtime to panels.

HMI Load

5002

TCP

Outbound

SCS (System
Configuration
Server)

This service is used to transmit configuration
data to panels.

VNC client

5500

TCP

Outbound

Sm@rtServer

VNC client connection

VNC server

5800*

TCP

Inbound

Sm@rtServer

VNC server connection HTTP
VNC server connection

5900*

TCP

Inbound

Sm@rtServer

SIMATIC Logon

16389*

TCP

Outbound

UMAC (User
Register / log on to a remote server.
Management to
the Access Con‐
trol)

Allen Bradley
Ethernet IP

44818

TCP

Outbound

Ethernet/IP
channel
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Reserved

49152 ...
65535

TCP/UDP

Outbound

Dynamic port range is used, for example, to
connect to the remote file sharing.

* Default port that can be changed by user configuration
** Port is assigned automatically.
*** Supported by WinCC Runtime Advanced only.

3.2

Notes on use

Contents
Information that could not be included in the online help and important information about
product features.

Change in response after upgrading
The new WinCC version contains new features and improvements as compared to the previous
version. The new version may therefore demonstrate slight differences in the names or the
response of properties and functions after the upgrade. Unlike in previous versions, the
standard properties of newly created objects can also be changed.
These differences in response may lead to errors when compiling the project.

Upgrading with subsequent device replacement (RT Advanced)
If you upgrade a project with a "Runtime Advanced" device and then replace the device with
a panel with HMI version 14.0.1.0 or 15.0.0.0, the configured data can be lost. After upgrading,
it is recommended that you either:
● First change the device to an IPC without adapting the screen and then switch back to a
PC station with Runtime Advanced. You can then change the device to a panel without
losing data.
● First change the device to a panel with an HMI device version lower than 14.0.1.0. You can
then change the device to a panel with the desired device version without losing data.

Working with standard user rights
If you are working with standard user rights in Windows 7, "User Account Control (UAC)" must
not be disabled.
The "User Account Control" is enabled in Windows 7 by default.
For more information on the "User Account Control", refer to the online help for Windows 7.

On-screen keyboard (RT Advanced)
Once you have opened the TIA Portal, you can no longer access the on-screen keyboard.
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To access the on-screen keyboard in Windows, use the following command: "Start > All
Programs > Accessories > Ease of Access > On-screen keyboard".

Installation on a computer with the regional setting "Turkish" (RT Professional)
If the computer is operated with the regional setting "Turkish" at the time of the installation,
WinCC Runtime Professional cannot be started.

Device change – character sets (RT Professional)
If you have configured different fonts on screen objects for multilingual texts in the various
project languages, you should check the screens after an HMI device replacement from a
panel to a PC-based Runtime. The configured fonts may change if the device is replaced.

Texts in the simulation (RT Professional)
If a Runtime language which does not correspond to an installed product language is used in
the simulation, system texts are shown in an installed product language. Depending on the
operating system and the installed product languages, this will be either English or Chinese.
If you wish to see all texts in Japanese, Korean or Taiwanese in the relevant language in the
simulation, you should first install WinCC without simulation. Then install WinCC Runtime
Professional with the required languages.

Online delta loading with user-defined cycles (RT Professional)
If you have configured new custom cycles in the "Cycles" editor, "Load > Software (compile
all)" command when loading the project. Online delta loading is not possible.

License transfer via S7USB
You always need to run WinCC to transfer a license to a panel via S7USB.

Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect
HMI device" menu command is not available in Automation License Manager, open command
line input and run the following command with administrator rights:
"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Installing East Asian project languages on a PC without an Asian operating system (Basic)
If you select an East Asian project language on a PC that does not have an Asian operating
system installed, the default font is marked as invalid in the "Runtime settings > Language &
font" editor.
To resolve this problem, open the "Regional and Language Options > Languages" dialog in
the Control Panel and enable the "Install files for East Asian languages" option.
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Operation on a network server (RT Professional)
The operation of WinCC Professional on a network server (e.g., domain controller, file and
name utility server, router, software firewall, media server, exchange server) is not permissible.

File browser on a Windows 10 PC with touchscreen
You can only operate the file browser dialog with a mouse, keyboard or on-screen keyboard
(without using the touch function) on a Windows 10 PC with touchscreen. We recommend
using the file browser dialog of the Windows operating system with the help of a script on a
touchscreen PC with Windows 10.

PostScript fonts
Only fonts that contain TrueType data can be used in the TIA Portal. PostScript fonts and open
type fonts that contain PostScript data are not supported.

3.3

Migration

Contents
Information that could not be included in the online help and important information about
product features.

Migrating an integrated project with ProTool objects
If you migrate a WinCC flexible project integrated in STEP 7 and the error message "PROTOOL
option package(s) missing in STEP 7" is output, you have installed WinCC flexible 2008 SP3
or later. Moreover, the project still contains objects that were configured using ProTool. Do not
open the project with WinCC flexible. To migrate the project, proceed as follows:
1. Open the project in the SIMATIC Manager.
2. Execute the "Save as" command in the "File" menu.
3. Enable the option "With reorganization" in the "Save project as" dialog.
4. Click OK.
5. Copy the project back to the original computer.
6. Restart the migration.

Migrating a WinCC V7 project: Border line of rectangles (RT Professional)
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1"
and "Draw insider border = yes".
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You migrate the WinCC V7 project to WinCC V15. To have the rectangle displayed correctly,
follow these steps.
1. Open the Inspector window of the rectangle.
2. Open the property list.
3. Disable "Widen border line inwards".

Progress bar
As long as the progress bar still shows a value of 100%, the software is still busy running
remaining tasks such as the closing of references. The software will not respond to user input
while this status is given.

Supported project languages in WinCC V7 (RT Professional)
Due to different Windows DotNet versions, there may be different names in WinCC V7 and
the TIA Portal within the same language. This can result in different sorting orders in the same
project.
The following table shows some examples with English spelling:
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TIA Portal

Bengali (Bangladesh)

Bangla (Bangladesh)

Bengali (India)

Bangla (India)

Chinese (Simplified, PRC)

Chinese (People's Republic of China)

Chinese (Simplified, Singapore)

Chinese (Singapore)

Chinese (Traditional, Hong Kong S.A.R)

Chinese (Hong Kong S.A.R)

Chinese (Traditional, Macao S.A.R)

Chinese (Macao S.A.R)

Chinese (Traditional, Taiwan)

Chinese (Taiwan)

French (Monaco)

French (Principality of Monaco)

Oriya (India)

Odia (India)

Sami (Inari, Finland)

Sami, Inari (Finland)

Sami (Skolt, Finland)

Sami, Skolt (Finland)

Sami, Northern (Norway)$Sami

Sami, Northern (Norway)

Spanish (Bolivarian Republic of Venezuela)

Spanish (Venezuela)

Spanish (Spain, Traditional Sort)

Spanish (Spain)

Spanish (Spain, International Sort)

Spanish (Spain)

Yakut (Russia)

Sakha (Russia)
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3.4

Engineering System

3.4.1

Screens and Screen Objects

Contents
Information that could not be included in the online help and important information about
product features.

Screen objects after HMI device replacement
If you upgrade a device to the new HMI device versions, you should check the screens
contained in the project. Because of the new appearance and improved operability, texts of
symbolic I/O fields may not be completely legible and may be concealed by operator controls.

Grouping of screen objects
When you group screen objects in WinCC, performance problems can arise in WinCC in the
case of large nesting depths.

ActiveX and .NET controls
For reasons of stability and performance, not all registered Active X controls can be configured
in WinCC. Only the controls visible in the selection dialog can be used in WinCC.
ActiveX and .NET controls are always positioned in the foreground in runtime.
The configuration of ActiveX and .NET controls on levels is not supported.

Use of WinCC Control Development
WinCC Control Development can be used without a license.
You can find the current version of WinCC Control Development for download in the Siemens
Industry Online Support, entry 109760182 "Control Development Kit" (https://
support.industry.siemens.com/cs/de/de/view/109760182).

Border line of rectangles (RT Professional)
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1"
and "Draw insider border = yes".
You migrate the WinCC V7 project to WinCC. To have the rectangle displayed correctly, follow
these steps.
1. Open the Inspector window of the rectangle.
2. Open the property list.
3. Disable "Widen border line inwards".
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Preview in screen window (RT Professional)
You use your own designs with shadows for screen objects. The screen objects can be
displayed in a screen window.
The shadows of the screen objects are not displayed in the preview of the screen window. The
response occurs only in the engineering system. It is displayed correctly in runtime.

Many visually different screen objects
The use of screen objects with many visually different properties (e.g. many different styles)
can reduce performance in runtime and can increase the amount of available memory space
used. Avoid using, for example, very many different corner radii: 0 pixel, 1 pixel, 2 pixels, 3
pixels, etc.

Dynamization of grouped objects (RT Professional)
For groupings with multiple nestings (group in group, faceplate in group, group in faceplate,
etc.), only the events of the outermost group and the innermost objects can be used for
dynamization with system functions. System functions that are configured at events of the
lower-level group or lower-level faceplate are not executed.
The configuration of simultaneous motion animation of an object group within this group can
be executed in runtime in a way other that what is expected. Check the sequence of the
execution in runtime and adapt the configuration if necessary.

Number of characters in text fields, lists and alarm texts
The number of characters that can be used in the text of a screen object is not constant. Control
instructions and formatting are taken into consideration when entering text data and the
maximum number of characters is reduced accordingly.

Transparency in WinCC as of V13
Transparent graphics can be displayed without any problems in runtime. This is true for all
Comfort Panels and WinCC Runtime Advanced as of version 13.0.
To use the transparency in a graphic view or in a graphic I/O field, the "Fill pattern" property
must be set to "Transparent" and the property "Use transparent color" must be disabled.
If the property "Use transparent color" is enabled in a device as of version 13.0, the
transparency of the graphic is lost and the transparent pixels are displayed in black. We
recommend that you check the "Use transparent color" property at the points of use of
transparent graphics after upgrading existing projects to device version 13.0 or higher. If the
graphics are not displayed correctly, disable this property.

Displaying SIMOTION PLC websites in the HTML browser
If the SIMOTION PLC websites are not displayed correctly in the HTML browser, insert ""/
basic"" after the website URL to display the websites in basic mode.
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Display differences between the configuration and the display on the HMI device
The display of the text configured in a screen object may be different on the HMI device due
to the display configuration. If you are using the options for automatic size adjustment in the
configuration, check the display on your HMI device in every language.
If texts that were configured with the "Fit object to contents" option cannot be displayed in full,
they are reduced slightly on the HMI device. If this reduction leads to a distorted display of
texts, disable the "Fit object to contents" option and expand the text with additional blanks.
Optionally, you can increase the width of the object or use a shorter formulation for the text.

GRAPH overview (RT Professional)
When upgrading to V14, the signature of the C function at the "Click" event is changed. The
propertyName parameter from the previous versions has been removed. Functions that access
this parameter are shown as faulty after the upgrade.

Dynamization in ProDiag Overview (RT Professional)
Dynamization of the "Allow operator control" property with a variable is not possible in the
"ProDiag Overview" object.

Initial value acquisition and criteria analysis: Supported instructions
The FBD instructions "AND" and "OR" are also supported for initial value acquisition and
criteria analysis.
The following instructions are supported for initial value acquisition and criteria analysis up to
and including the instruction box:
● "Set/reset flip-flop"
● "Reset/set flip-flop"
● TP, TOF and TONR timers
● CTU, CTD, CTUD counters

Updating faceplates with the UDTs of the type "IEC timer"
The "ST" element was automatically removed from the user-defined PLC data types (UDT)
that use the "IEC timer" data type. Adapt the faceplates containing these UDTs to a new version
of the UDT without an ST element.
A detailed description of this can be found in the FAQ with the entry ID "109740393" in the
SIMATIC Customer Online Support.

Higher-level controls with visibility animation
The higher-level configuration of table-based controls with visibility animation can lead to
problems for touch operation with devices using the operating system Windows CE/Embedded
Compact.
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SVG graphics
The SVG graphics are converted to Siemens SVG Standard. Note the following restrictions
when using SVG graphics:
● The CSS definitions are converted to inline attributes.
● The embedded scripts and non-local URL links are not supported in the SVG graphics and
are removed from the original graphics during conversion.
● The use of SVG graphics with embedded graphics and animations is not supported.
● The use of large SVG graphics affects performance due to the load associated with the
increased characters.
The representation of SVG graphics depends on the browser used.

Editing SVG graphics
It is not possible to open SVG graphics in an external editor using the "Edit" command.

System diagnostics view: "HMI access" access protection
When using the "HMI access" protection level in conjunction with the SIMATIC S7-1200 PLC,
correct display of the diagnostic data can only be ensured as of firmware version 4.1.

Fonts in the header of window objects
The font that you configure in the runtime settings of the device is not used in the alarm window,
system diagnostics window and dialog headers.

Invalid graphic types in graphics lists after upgrading (WinCC Runtime Professional)
When you upgrade your project to TIA Portal version V15, invalid graphic types in the graphics
list result in compiling errors that were displayed as warnings in V14.
To avoid error messages during compiling, you need to manually correct the graphic type in
the graphics list if necessary.

Multilingual graphics in faceplates
In a faceplate, insert a graphic in a screen object. This graphic is used in all specified project
languages.
If you open the graphic using the shortcut menu command "Edit" with the option "Edit graphic
centrally", the graphic is changed only for the currently set project language after editing and
saving in an external editor, such as MS Paint. The change of the corresponding graphic is
visible in all objects that use this graphic.
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Use of multilingual graphics (RT Professional)
Graphics are stored in the runtime project in the language that you specified in the Runtime
settings under "Language & font > Language selection > Runtime language for non-multilingual
objects".
The use of of different graphics for individual runtime languages has no effect when switching
languages in runtime.
Remedy: Configure individual graphic displays with the desired graphic in the set runtime
language for non-multilingual objects and switch these to visible or invisible according to the
runtime language in the script.

PLC code view (RT Professional)
The button "Show whole function block" of the PLC code view can only be executed correctly
when the names of the following objects do not contain any special characters, such as a
comma:
● PLC name
● DB/FB name
● DB/FB interface element name

Network changes in the PLC code display (RT Professional)
When a ProDiag alarm is pending, network changes in the PLC code view are updated in
runtime.
In order for network changes in the PLC code display to be displayed correctly for criteria
analysis, the message must be triggered again.

PDF view (RT Advanced)
With the PDF view, no pop-up notes (sticky notes) can be displayed in PDF files.

See also
http://support.automation.siemens.com (http://support.automation.siemens.com/WW/view/en/
62101921)

3.4.2

Tags and connections

Contents
Information that could not be included in the online help and important information about
product features.
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Multiplexing tags (Basic Panels)
If you multiplex a tag with an external tag on a Basic Panel, the address is read from the PLC
in runtime during the first read cycle. The value of the address read is not available until the
second read cycle.

Tag names in faceplates (RT Professional)
Use of the "." or "@" character in names of tags in faceplate types is not permitted. Do not use
these special characters in the tag names in faceplates.

Tags with symbolic addressing and "Char Array" data type (RT Professional)
Tags with symbolic addressing and the "WString" data type are not released for communication
of RT Professional and SIMATIC S7-1200 V3.

Length specification for tags of the "String" type (RT Professional)
The length specification for the internal HMI tags of the "String" type have no effect in the "Tag"
editor. If you want to limit the tag length of an input field or output field, for example, limit the
length using VB scripting or C scripting.

Tag of the "String" type for connections with SIMOTION PLCs (Panels, RT Advanced)
The length of the String tags must not exceed 210 characters for SIMOTION controllers.
It is possible to create a String tab with more than 210 character in the engineering system.
However, the tag in question is not written in Runtime. A message stating that the value limit
is outside the tag appears.
In this case, adjust the length of the String tag.

Tags under "Tag box ID"
The tag that you configure under "Tag box ID" with "Runtime Settings > General" may only be
used in read-only mode.
No values may be written in this tag, however, they may be read in scripts, for example, or
output to screens.

Array elements in WinCC
If you have connected an HMI tag with an array from a STEP 7 data block which does not start
with a low limit of 0, the array elements are mapped in WinCC to the low limit of 0.
To ensure that you do not have to rethink between the STEP 7 indices and the WinCC indices
when accessing the individual array elements, the low limits of arrays should also start at 0 in
STEP 7.
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Use of 64-bit data types
The use of 64-bit data types may result in a slight loss of accuracy as these data types are
mapped in the HMI channel to the data type Double. It is therefore possible that integer data
types are displayed with decimal places.

System diagnostics of PLCs in the R/H system in non-redundant mode
Two PLCs and two corresponding connections are configured in an R/H system. If the R/H
system is not in redundant mode, it may happen that the system diagnostics views of the
connections show different diagnostics status symbols for the same PLC.

3.4.3

Alarm system and alarm displays

Contents
Information that could not be included in the online help and important information about
product properties.

Boolean tags in alarm logs
Bool type tags are recognized as 0 and -1 in the alarm log. If you use a text list that is controlled
by a tag of the type Bool in an alarm log, then add the entry for the value -1 to the corresponding
text list.

PLC alarms
A PLC alarm is only visible in the "Alarms" editor of an HMI device if there is an instance data
block for this FB.

Controller alarms in runtime (WinCC Professional)
If upgrade a project from versions V13SP1 or V13 SP2 to versions V14, V14 SP1, V15.x, you
need to compile the project and load it in the controller and HMI device. Otherwise, the
controller alarms are shown crossed out in the alarm view.

Controller alarms in runtime (Panels and RT Advanced)
If the property "Alarm > Basic settings > Information only" was selected for a controller alarm,
it was not displayed in the alarm view in WinCC.

"Automatic update" of controller alarms activated on the HMI device (Panels and RT Advanced)
For controller alarms that are displayed in the alarm log, the following applies:
The info texts of the alarms are not logged and show "###Text missing###" when an alarm
log is displayed in runtime.
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Copying projects with integrated connections
If you copy the devices with their integrated connections (between HMI devices and controllers)
from a project to a global library and insert it from there in a new project, then the information
about controller alarms can get lost on the HMI device. To avoid this loss of information, first
copy all controllers and only then all HMI devices to the new project.

Alarm 20013 on global scripts (Panels and RT Advanced)
In contrast to the description given in the help, the alarm with the number 20013 is only output
on Runtime start if the script engine has not yet been initialized.
This alarm has no effect on the functioning of VB scripts in Runtime.

Logging alarm texts with more than 6 values (Panels and RT Advanced)
If an alarm text contains more than 6 values, only the first 6 values are saved in the log file
after logging.
An alarm view configured for the display of the logs shows all values contained in the alarm
text.

3.4.4

System functions and scripts

Contents
Information that could not be included in the online help and important information about
product features.

Scripts for service projects (RT Professional)
Since no interactive user is usually logged in service projects, C scripts and VB scripts lead to
problems in the following cases:
● When the scripts require interaction, for example, operator input.
● When the scripts show message boxes.
There is no common data area for C scripting in service mode. Thus, for example, no global
C variables can be exchanged between the "Scheduled tasks" and "Screens".

Trigger tags of user-defined functions (RT Professional)
If you have configured an HMI or PLC user data type on a screen, you cannot use the elements
of the user data type as trigger tags in newly created or changed user-defined user functions.

Find and Replace in local scripts (RT Professional)
Use the "Find and Replace" function to find and replace texts within editors. It is not possible
to use Find and Replace in local scripts.
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User-defined functions in faceplates
If you want to access tags in a faceplate with a user-defined function, you cannot dynamically
compose the name of the tag.

"SimulateTag" system function (Basic Panels)
If you use the system function "SimulateTag" with a short cycle time on a Basic Panel, the HMI
device may be overloaded.

System functions of the bit processing (Mobile Panels and RT Advanced)
Because of events it is not possible to manipulate bit arrays. System functions, e.g. InvertBit,
SetBit etc., must not contain any elements of a bit array as argument.

Properties no longer used (Comfort Panels and RT Advanced)
In WinCC V13, many new visual properties have been introduced and many existing properties
have been harmonized.
In the course of revision of the object properties, some properties that could be used in VB
scripts in earlier versions of WinCC are no longer supported for use in WinCC V13. Scripts
that use properties that are no longer supported remain valid, but the relevant calls within the
scripts have no function. These limitations pertain exclusively to Comfort Panels and RT
Advanced in device version V13.0.
The following table shows the properties of screen objects that are no longer being used:

Property

Screen object

BorderBrightColor3D

Slider

BorderColor

Text field, I/O field, symbolic I/O field,
date/time field

BorderInnerWidth3D

Slider

BorderOuterWidth3D

Slider

BorderShadeColor3D

Slider

BorderStyle3D

Text field, I/O field, button, symbolic I/O field, graphic I/O field,
date/time field, bar, switch

BorderWidth

Text field, symbolic I/O field

CenterColor

Gauge

DialColor

Gauge

EdgeStyle

Text field, I/O field

Debugging VB scripts
You can use the "Debug" object to enter custom texts in a debugger. The object has the
methods "Write" and "WriteLine". You can find additional information about the "Debug" object
on the Internet (https://msdn.microsoft.com/en-us/library/wk3y866c(v=vs.84).aspx).
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You can use the "Err" object to respond to error messages that are generated by another
object. The object has the methods "Raise" and "Clear".
You can find additional information about the "Err" object on the Internet (https://
msdn.microsoft.com/en-us/library/sbf5ze0e(v=vs.84).aspx).

Transferring parameters to VBScripts (Panels and RT Advanced)
In WinCC, you can define whether the parameters of VB scripts "ByRef" (address of the
parameter) or "ByVal" (value of the parameter) are transferred.
Transferring the address of the parameter using "ByRef" (Call by Reference) is possible only
for the internal tags of the VB script. With HMI tags, the value of the parameter is always
transferred regardless of whether the parameter was defined as "ByRef" or as "ByVal".

System functions with the parameter "Processing status".
For system functions, such as "SaveDataRecord" for example, you can only specify HMI tags
for the "Processing status" parameter.

Functions of the PLC code view (RT Professional)
The functions of the PLC code view "ShowCodeViewerFromAlarm" can only be executed
correctly when the names of the following objects do not contain any special characters, such
as a comma:
● PLC name
● DB/FB name
● DB/FB interface element name

Accessing the "Height" and "Width" properties of some VBS objects in runtime
Contrary to what is described in the help, you have read access to the "Height" and "Width"
properties for the following VBS objects:
AlarmView, Bar, BatteryView, Button, CameraControl, Clock, DateTimeField,
FunctionTrendControl, Gauge, GraphicIOField, GraphicView, HTMLBrowser, IOField, Line,
MediaPlayer, PDFView, PLCCodeViewer, Polygon, Polyline, ProDiagOverview,
ProtectedAreaNameView, RangeLabelView, RangeQualityView, RecipeView,
S7GraphOverview, Slider, SmartClientView, StatusForce, Switch, SymbolicIOField,
SymbolLibrary, SysDiagControl, TextField, TrendView, UserView, WLanQualityView,
ZoneLabelView, ZoneQualityView
With the following objects you have no access to the "BorderColor" property for Runtime
Advanced:
TextField
You can find additional information on the VBS object model in the FAQ with entry ID
"53752382" in the SIMATIC Customer Online Support:
https://support.industry.siemens.com/cs/ww/en/view/53752382 (https://
support.industry.siemens.com/cs/ww/en/view/53752382)
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3.4.5

Reports

Contents
Information that could not be included in the online help and important information about
product features.

Printing reports (Panels)
Depending on the printer used, the objects placed at the edge of the reports can be cut off
during printing.
Make sure that your report has a suitable size.

3.4.6

Recipes

Contents
Information that could not be included in the online help and important information about
product features.

Arrays in recipe elements
If you have configured both an array as well as the elements of this array for recipe elements
of a recipe, the loading of data records aborts with the following error message: "290055: Import
of data records aborted with error"
Use either the array or just the array elements for recipe elements of a single recipe.

3.4.7

User administration

Contents
Information that could no longer be included in the online help and important information about
product features.

3.4.8

Communication

Contents
Information that could not be included in the online help and important information about
product features.
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Establishing a connection to WinCC Runtime Advanced
Please ensure that the device version configured in the Engineering System matches the
installed Runtime version; otherwise, communication when the project is loaded will not be
established or will be delayed.
If the device version does not match the installed Runtime version, you have the following
options:
1. Change the device version configured in the Engineering System.
2. Install the version of WinCC Runtime Advanced corresponding to the configured device
version.

Connection changing for non-integrated connections
If you want to change the communication from a non-integrated connection to another nonintegrated connection, for example from Omron to Mitsubishi, you must ensure that the data
types of the tags are also supported in the new connection.

Connection interruptions with Mitsubishi PLCs
After multiple connection interruptions, a situation may arise where all the connection
resources of the Mitsubishi PLC are in use and the connection can no longer be established.
We recommend that you check these connection resources in the PLC program of the
controller and enable them again.

Self-signed certificates (RT Professional)
Self-signed certificates are no longer supported.
If a self-signed certificate is detected on the server side, the authentication takes place via the
previously distributed PSK key (pre-shared key). If the PSK keys of the communication
partners do not match, no communication is established.

Communication between WebClient and Sm@rtServer
Java is no longer supported by future browser versions.
In these cases, use the following alternatives as Sm@rtClient:
● Sm@rtClient.exe
● Sm@rtClient app for smartphones
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Accuracy of the "DTL" data type
The "DTL" data type supports time information down to the nanosecond range. Because panels
only support time information down to the millisecond, the following restrictions arise when
used at the area pointers:
● Area pointer "Date/time"
For the transmission of time information from a panel to the PLC, the smallest unit of time
is 1 millisecond. The value range from microseconds to nanoseconds of the "DTL" data
type is filled with zeros.
● Area pointer "Date/time PLC"
For the transmission of time information from a PLC to a panel, the range from
microseconds to nanoseconds is ignored. The time information down to and including
milliseconds continues to be processed on the panel.

Limited number of possible HMI connections
An error message is displayed during compilation of a device indicating that the configuration
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that
the maximum number of possible connections of the HMI device or PLC has been exceeded.
Check the maximum number of available connections. Consult the device manuals of the
devices you are using.

Use of PROFINET IO with panel HMI devices
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC,
you can define an offset for the address area of the inputs and outputs during configuration in
HW Config.
The following restriction applies when a PROFINET IO-capable S7-400 CPU is used with one
of the HMI devices listed below:
The offset for the start of the address area of the inputs must not be greater than the offset for
the start of the address area of the outputs.
The restriction applies to the following HMI devices:
● Mobile Panel 177
To configure the address parameters, open the PLC that contains the CPU of the 400 series
in HW Config. Select the HMI device that is connected via PROFINET IO from the station
window of HW Config. A table with the properties of the HMI device is displayed at the bottom
of the station window in the detail view. Select the line containing the addresses of the HMI
device in the table and open the object properties using the shortcut menu.
Enable the "Addresses" tab in the "Object properties" dialog. Configure the offset for the inputs
under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start".

RT Advanced communication via Station Manager (SIMATIC NET) with an S7-1200
For communication of a SIMATIC S7-1200 with a PC with WinCC RT Advanced via a router,
the following restrictions apply to the PC:
● Windows 7: Only with installed SIMATIC NET 8.1
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These restrictions also apply when you use the Station Manager. Connections with the help
of the Station Manager of Runtime Advanced are always treated as routed connections.

Changing the IP settings and device name of a PLC in the Control Panel of the HMI device (Basic
Panels)
The Control Panel is open in the "Service and Commissoning > IP-Adaptation" menu on the
HMI device. If you want to change the IP settings or the device name of a PLC, please note:
In the Engineering System, you need to have selected the following options in the Inspector
window of the PLC under "Properties > General > PROFINET interface > Ethernet addresses":
● "Set IP address using a different method"
● "Set PROFINET device name using a different method"

HMI connections to SIMATIC S7-1200 PLCs
HMI connections to SIMATIC S7-1200 PLCs with firmware versions earlier than V2.0 are not
possible.

"Set the IP suite (address) of the PLC in the Control Panel" with SIMATIC S7-1200 V1 (Basic Panels)
The function "Set the IP suite (address) of the PLC in the Control Panel" has not been approved
for the following PLCs:
● SIMATIC S7-1200 V1

Connections via PROFIBUS DP
When a connection between a PLC and an HMI device via PROFIBUS DP is interrupted and
then re-established, sporadically all other PROFIBUS DP connections in the communication
network are interrupted and re-established.
De-energize the disconnected station before reconnecting it.

Switching a connection
A connection may be interrupted when it is switched from an HMI device to a SIMATIC
S7-300/400, SIMATIC S7-1500 or SIMATIC S7-1200 controller.
Note the following settings in the SIMATIC S7-1500 or SIMATIC S7-1200 PLCs:
● Absolute addressing of tags
● The "Disable PUT-GET communication" option must be selected
● The "Complete protection" protection level may not be set

Communication of Runtime Professional with SIMATIC S7-1200
In productive operation, communication of WinCC Runtime Professional with SIMATIC
S7-1200 is only released for single-user systems.
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RT Advanced in the Station Manager
If RT Advanced and WinAC RTX use the same communication processor of a PC, HMI
communication with SIMATIC S7-1200 and SIMATIC S7-1500 is not possible.

Raw data communication in redundant projects (RT Professional)
Simatic.NET, Named Connections and various communication blocks, such as BSEND/BRCV,
for example, can only be used to a limited extent in a redundantly configured PC station
because the connection parameters for the redundant partner server cannot be configured.

Non-integrated connection to a SIMATIC S7-1500 software PLC (RT Advanced)
A non-integrated connection between an HMI device and a SIMATIC S7-1500 software PLC
is not supported in WinCC.

Transfer areas of the operating mode IO device and DP slave of the HMI devices
If you have activated the operating mode "IO device" or "DP slave" for HMI devices, no transfer
areas should be added or deleted in the properties of the HMI device. If you have inadvertently
deleted or added a transfer area, disconnect and reconnect the controller.

Getting diagnostics data by means of HMI devices
In contrast to the description of diagnostics icons for modules and devices in the information
system, the following icon has the meaning specified here for HMI devices:
Icon

Meaning
No diagnostics data is available.

PROFIenergy communication
To set up PROFIenergy communication, contact Customer Support.

3.5

System-wide functions

Contents
Information that could not be included in the online help and important information about
product features.

Using system diagnostics in the device proxy
To use the system diagnostics function in an IPE device proxy, for example, a system
diagnostics view, insert the PLC alarms as content of a device proxy.

Readme
Programming and Operating Manual, 10/2018

87

WinCC
3.6 Compiling and loading

Initialize the device proxy with data from a project of the previous version
A device proxy cannot be initialized with the data from a project of the associated full version
in a project with the Service Pack version.
Upgrade the source project to the Service Pack version to initialize the device proxy in the
target project with the data from the source project.

Import and export of library texts
The following objects are not supported when importing and exporting library texts:
● Import: Recipes, Recipe elements, Recipe data records, HMI alarms, Text list entries,
Screens, Reports.
● Export: Text list entries, Screens, Reports.
● Import and export of library type "Screen".

3.6

Compiling and loading

Contents
Information that could no longer be included in the online help and important information about
product features.

Compiling and loading
If internal errors or warnings occur during compiling, compile the complete project using the
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device.
Before you start productive operation with your project, compile the entire project using the
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device.
If you are using HMI tags that are connected to control tags in your project, compile all modified
blocks with the command "Compile > Software" in the shortcut menu before you compile the
HMI device.

Incorrect installation of ProSave
If you receive an error message during installation of ProSave when loading data to a target
device or maintenance of an HMI device, then you cannot remedy this error using the repair
function of setup. Remove ProSave via the Control Panel. Then start setup and install the
"ProSave" component again.

Checking the address parameters
When an HMI device is compiled in the project tree with the command "Compile > Hardware
and software (changes only)" in the shortcut menu, the address parameters of the HMI device,
such as the IP address, are not checked. If you want to ensure that the address parameters
are checked as well, you will have to compile the HMI device using the "Compile" button in the
"Devices & Networks" editor of the toolbar.
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Error message when downloading data to the PLC
A panel and a PLC are connected and communicating with other.
If a tag is accessed while downloading data from the panel to the PLC, an error message is
displayed on the panel.

Delayed reaction in the "Extended download to device" dialog
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface"
and "PG/PC interface" do not match the settings on the HMI device, this can result in the
application not responding for up to a minute.

Extended download with an S7-1200 and a Comfort Panel
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the PG/
PC. You open the "Extended download to device" dialog for the Comfort Panel.
If you enable the option "Show all accessible devices", it may occur that the application stops
responding.

Project transfer via USB
If you have connected more than one HMI device via USB to your configuration PC, project
transfer is only possible to the last connected device.

Comfort panels as of device version 13.0: Backing up data while loading projects
If the transfer is interrupted for Comfort Panels with a device version 13.0 or higher, WinCC
automatically ensures that no data is lost and that existing data is only deleted on the HMI
device after complete transmission.

Displaying characters in transfer alarms
If characters are not displayed correctly in the transfer alarms during transfers to HMI devices
with the device version V12 or older, please check the region and language settings in
Windows. Set the corresponding language under "Language for non-Unicode programs".

Missing fonts (panels)
The following fonts no longer belong to the standard installation pack in Windows 10 and are
not pre-installed:
● MS PGothic (is used as standard for displaying Japanese characters)
● Gulim (is used as standard for displaying Korean characters)
● MingLiU for Chinese (is used as standard for displaying Chinese characters for Taiwan,
Hong Kong and Macao)

Readme
Programming and Operating Manual, 10/2018

89

WinCC
3.7 Runtime
If a font is not installed, an error message is displayed in the engineering system. The error
message appears in every TIA Portal session if you navigate to “Runtime settings > Language
and font” or open screen objects which use the missing font. The missing font is replaced with
a suitable font by the TIA Portal.
Missing fonts cause problems during compilation and in Runtime.
For example, if you open an error-free V13 SP1 project that was created on a configuration
PC with Windows 7 on a configuration PC of V14 SP1 with the Windows 10 operating system,
error messages can be output during compilation because of the fonts that are not installed.
You can find more detailed information on fonts in Windows 10 at https://support.microsoft.com/
en-us/kb/3083806 (https://support.microsoft.com/en-us/kb/3083806)
Solution
1. Compile the project before you transfer it to your HMI device. How to determine whether
the fonts you require are missing.
2. Install these fonts and/or the corresponding Windows language pack.
Alternatively, you can also compile the projects with substitute fonts.
The missing font is saved in the configuration. As soon as this font is available again, it is
displayed and used in the configuration.

Reducing the project size
When you compile your HMI device, an alarm appears informing you that the size of your
project is approaching the system limits for the corresponding HMI device. In this case, perform
a complete compilation of the software to reduce the project size. To do this, use the command
"Compile > Software (rebuild all)".

3.7

Runtime

3.7.1

Notes on operation in Runtime

Contents
Information that could not be included in the online help and important information about
product features.

Focus in runtime
If you have configured a low-contrast combination of focus color and border color for an HMI
device with version 12.0.0 or earlier, the focus may no longer be identifiable in runtime after
you change the device version in the TIA Portal. Change one of the two colors.
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Language behavior - Layout of on-screen keyboard
The layout of the on-screen keyboard does not change when you switch to a runtime language
that is not installed for the keyboard layout.
In this case, the language setting for the keyboard remains set at the most recent valid
language or the language setting for the default keyboard layout of Windows is used.

Tag values exceed the maximum length
You enter a character string in a string tag via an I/O field. If the character string exceeds the
configured number of tags, the character string will be shortened to the configured length.

Empty alarm texts
Runtime is running with a project. The project is saved on a network drive.
In the event of interruptions to the network drive connection, Runtime may attempt to load
alarm texts from the network drive.
In the event of disconnection, the alarm window or the alarm view remains empty.
To avoid this, copy the project to a local drive before the starting the project in Runtime.

Duration of log initialization (Panels, RT Advanced)
Initialization of the logs on some storage media can take up to 5 minutes. The successful
completion of initialization is immediately confirmed by a system event. If there is no storage
medium for logging when Runtime starts, the appearance of the system event can also take
up to 5 minutes.

Large logs delay the ending of Runtime (Basic Panels 2nd Generation)
When very large logs are used, ending Runtime can take a long time. Use segmented logs as
an alternative to very large circular logs.

Slow reaction of SmartServer
The following programs may start and respond very slowly with Windows 7:
● HMI TouchInputPC
● SmartServer: <Ctrl+Alt+Del> shortcut in the logon dialog
The delay is caused by the callback for the Internet certificate validation.
Remedy:
You can find the following files
on the product DVD under:
Support\Windows7\CRL_Check or CD_RT\ Support\Windows7\CRL_Check\:
● DisableCRLCheck_LocalSystem.cmd
● DisableCRLCheck_CurrentUser.cmd
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1. Run the "DisableCRLCheck_LocalSystem.cmd" file with administrator rights. Select the
command "Run as administrator" from the shortcut menu of the file.
2. Reboot the PC.
If the problem persists, follow these steps:
1. Double-click the file and run the "DisableCRLCheck_CurrentUser.cmd" file with user rights.
2. Reboot the PC.
Note
The callback for the certificate validation is disabled for all users or PCs. To restore the
original state, perform the following files:
● RestoreDefaults_LocalSystem.cmd
● RestoreDefaults_CurrentUser.cmd
You can find the files in the following directory of the product DVD:
● Support\Windows7\CRL_Check or CD_RT\Support\Windows7\CRL_Check\

Ending screensaver on the Sm@rtServer
When the screensaver is active on the Sm@rtServer on the server HMI device, you require
write access to the Sm@rtClient side in order to end the screensaver on the server HMI device.

Avoiding corrupt files during power failure
If a power failure occurs in Windows systems while the WinCC system is active, files may be
corrupt or destroyed. Operation with the NTFS file system provides better security.
Secure, continuous operation is only ensured by using an uninterruptible power supply (UPS).

3.7.2

Notes on operation of panels in Runtime

Contents
Information that could not be included in the online help and important information about
product features.

Using the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels.
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Backup on the memory card of the PLC (Basic Panels)
Create the backup file "A.psb" on the memory card of the PLC. An error, for example a
connection break, occurs when creating the backup.
This will create a corrupt file on the memory card of the PLC. Such a file has "~$" as prefix.
Delete the file with the prefix "~$" if you want to save a backup again under the same name
"A.psb".

Panel Data Storage and S7-1500F (Basic Panels)
The "Panel Data Storage" PDS function cannot be used on Basic Panels in conjunction with
S7-1500F when the password for the protection level "Full access incl. fail-safe" is used.

"Panel Data Storage" function (Basic Panels)
The "Panel Data Storage" (PDS) function provided by Basic Panels is only supported by
SIMATIC S7-1200 as of firmware V4.0 and SIMATIC S7-1500. For the PDS function, the panel
must be connected directly with the CPU and must not be connected via the CP.

Fonts with file extension ".ttx"
The fonts with the file extension ".ttx" are available on all panels and Runtime Advanced and
can be correctly displayed on all devices, for example, the "WinCC_flexible_smart" font.

Languages in Runtime (Comfort Panels)
If the language set under "Region and Language" is not supported in Runtime on the HMI, all
dialogs are displayed in the default language "English".

Mass data transfer with USB
If you have installed Windows 10 on the configuration PC, the "USB" transfer channel is not
available.
This restriction applies to the following devices and tools:
● Basic Panels: KP300 Basic, KP400 Basic, TP1500 Basic
● Mobile Panels: 170 series and 270 series
● WinCC Engineering System
● "ProSave" service tool
Note
The "USB" transfer channel remains available if Windows 7 is installed on the configuration
PC.
Solution

Readme
Programming and Operating Manual, 10/2018

93

WinCC
3.7 Runtime
Use other transfer channels to transfer the project data, such as the "Industrial Ethernet" or
"PROFIBUS DP" channel.

Modifying the IP address and device name for Panels
On Comfort Panels, the IP address or the device name can be modified even during runtime.
On Basic Panels, modification of the IP address or the device name during runtime is not
possible.

3.7.3

Notes on operation of Runtime Advanced

Contents
Information that could not be included in the online help and important information about
product features.

Starting Runtime
Only WinCC Runtime V15 can be started in TIA Portal V15. WinCC Runtime V11.02, V12,
V13, V13 SP1, V14 and V14 SP1 can be simulated in TIA Portal V14 SP1.

Screen saver on computers with Windows 10
On a computer with Windows 10, an activated screen saver is no longer terminated when an
alarm of the "error" class is output.

Windows 10 in tablet mode
It is not recommended to use Windows 10 in tablet mode.
When running applications in tablet mode in Windows 10, for example Runtime Advanced,
Sinumerik Operate, etc., these applications are minimized after starting.

Authorization for starting Runtime (RT Advanced)
On a computer running the 32-bit version of Windows 7, WinCC Runtime Advanced can only
be started if a user is a member of the automatically created group "Siemens TIA Engineer".

.Net-Controls in Runtime
If you have incorporated a .Net control in your project as "Custom .Net control", you have to
copy the files belonging to these controls to the installation directory of WinCC Runtime, e.g.
"C:\ProgramFiles\Siemens\Automation\WinCC RT Advanced". Otherwise, the control cannot
be loaded in Runtime.

94

Readme
Programming and Operating Manual, 10/2018

WinCC
3.7 Runtime

Disabling automatic checking for software updates
If the Engineering System is installed together with Runtime on a PC, the operator gets
notifications above software updates. For the system to run reliably on a multi-user system,
the same software version must be installed on all PCs.
It is possible to disable the automatic checking for software updates and to thus improve
performance.
To disable the automatic checking for software updates, go to "Settings > General > Software
updates" and clear the "Check daily for updates" check box.

3.7.4

Notes on operation of Runtime Professional

Contents
Information that could not be included in the online help and important information about
product features.

User authorizations within the operating system
1. All user must be added to the "SIMATIC HMI" user group. This also applies to users who
want to open WinCC projects remotely.
2. The storage folders of the projects must have the NTFS authorizations "SIMATIC HMI" with
full access and "SIMATIC HMI Viewer" with read access. The authorizations must be
inherited for all subordinate objects.
3. Members of the Windows user group "SIMATIC HMI" should not simultaneously be
members of the Windows user group "SQLServerMSSQLUser$<Computername>
$WINCC". The members of this group have administrator rights to the SQL server.
Therefore remove all Windows users from this group for whom restricted access to the
WinCC database is sufficient.

Windows 7: Locking shortcuts
If you want to lock shortcut keys in Windows 7, you must change the group policies in the
administrative tools of the operating system.
A detailed description of this can be found in the FAQ with the entry ID "44027453" in the
SIMATIC Customer Online Support:
Internet: WinCC FAQ 44027453 (http://support.automation.siemens.com/WW/view/en/
44027453)
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Undocked toolbars
If the setting "Always on Top" is used for the Windows taskbar, undocked toolbars can be
hidden behind the Windows taskbar in Runtime. Follow the steps below to show the toolbars
again:
1. Select the "Properties" command in the shortcut menu of the taskbar.
2. Disable "Keep taskbar on top of other windows".

Fault in the connection between the server and the client
If the connection between the server and client is faulty, check the settings of the PG/PC
interface. TCP/IP(Auto) should not be used for the "Interface Parameter Assignment Used".
Used fixed IP addresses instead.

Fault in the connection between the server and the client
If the computer is simultaneously used as a server with the engineering system and a client
cannot establish the connection to the server, you should check the releases set on the server.
1. Exit Runtime on the server.
2. Select the command "Find computer..." in the shortcut menu of the network environment
on the desktop of the server.
3. Enter the name of the server as the computer to be found.
4. Open the computer found to see the released directories.
5. Remove all the releases that begin with "WinCC_Project_HMI". Information on this is
available in the documentation for the operating system.
This malfunction is caused by the use of the command "Save as..." in conjunction with the
startup of the Runtime of this new project. You can make copies of the projects for backup
purposes using the "Save as..." command. You should, however, continue to work with the
original project.

Starting WinCC Runtime Professional
If Engineering System and Runtime are operated on one computer, Runtime or simulation for
a project opened in the Engineering System should only be started and ended using the TIA
Portal. Other options, for example, the symbol in the taskbar information area, should not be
used.
When you configure autostart on the client, you are required to enter the logon name and
password for each registered server project. To assign each server a logon name, the entry
of the respective project path must be confirmed with the "Apply" button. This means that you
must enter a logon name and password twice for redundant or alternative projects.
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Setting the services for the SQL server
In order to ensure the full functionality of the SQL server for WinCC and WinCC Runtime, you
need to check the SQL server settings.
1. Start "Programme > Microsoft SQL Server 2014 > Configuration Tools > SQL Server 2014
Configuration Manager" in the Start menu.
2. Click "SQL Server Services" in the tree.
3. Check the services "SQL Server (WinCC)", "SQL Server (WINCCPLUSMIG)" and "SQL
Server Browser". "Automatic" must be entered for "Start Mode". "LocalSystem" must be
entered for "Log On As". Change the settings, if necessary.
4. Click "SQL Server Network Configuration" in the tree.
5. Click "Protocols for WinCC".
6. Check the "TCP/IP" protocol. "Enabled" must be entered for "Status". Change the settings,
if necessary.

"Report system error" in WinCC Runtime Professional
The "Report system error" functionality is limited in WinCC Runtime Professional in conjunction
with an S7-300 or S7-400. In an alarm view, only one alarm is ever displayed for each
diagnostics type. Alarms on other errors of the same diagnostics type are not displayed.

WinCC interface and 64-bit operating system
The open interfaces of WinCC Runtime Professional do not offer native 64-bit support. Runtime
API, VBS and the WinCC OleDB provider are primarily affected by this. To be able to use
WinCC interfaces with a 64-bit operating system, note the following:
- VB scripts cannot be started by simply double-clicking. You must explicitly use the 32-bit
version under "syswow64\wscript.exe".
- .NET applications that use the WinCC API have to be explicitly compiled as 32-bit
applications, not with "AnyCPU", but with "x86".
- C++ applications must not be compiled as 64-bit applications.

Dynamic graphics in WinCCViewer RT
If you use dynamic graphics from a graphics collection, e.g. linked with scripts, these graphics
are not updated in the WinCCViewer RT.
Select the "User-defined" option under "Runtime Settings > Graphic Settings".
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Runtime Professional: Loading a project without connection to the configuration PC
Before you begin to load a project on the operator station, backup data such as "User
administration" and "Recipe data".
1. User administration data are overwritten by default.
Therefore, configure two buttons in your project for exporting and importing the user
administration with the system function "ExportUserManagement". The data only needs to
be exported if you have made changes to the user view in Runtime.
2. In the "Load preview" dialog, specify whether recipe data should be overwritten when
loading the project.
You can save recipe data in the recipe view using the operator controls "Export log" and
"Import log".
Note that the most recently imported or loaded data are used in Runtime.

Operation on a network server
Operation of WinCC Runtime Professional on a network server (e.g. domain controller, file
server, name utility server, software firewall, media server, exchange server) is not permitted.

Connection with S7-1200 in system diagnostics
Only a WinCC Runtime Professional HMI system can be connected with an S7-1200 (up to
V3) when you use system diagnostics.

Disabling automatic checking for software updates
If the Engineering System is installed together with Runtime on a PC, the operator gets
notifications above software updates. For the system to run reliably on a multi-user system,
the same software version must be installed on all PCs.
It is possible to disable the automatic checking for software updates and to thus improve
performance.
To disable the automatic checking for software updates, go to "Settings > General > Software
updates" and clear the "Check daily for updates" check box.

Restriction in the online delta loading capability
When you replace a design, the online delta loading capability of the project is lost. TIA Portal
does not output an error message in this case.

Screen objects in reports as PDF
The quality of the screen objects in the reports that you generate in Runtime as PDF files
depends on the PDF printer drivers used.
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Projects in Runtime after Windows 10 update
You have installed Windows 10 version 1709 on a PC with WinCC Professional V15 and a PC
with WinCC Professional RT V15. You have performed a Windows 10 update to version 1803
on the Runtime PC. After the Windows 10 update, it may no longer be possible in Runtime to
manually open a project loaded from the engineering system PC.
Remedy: Set the start type of the service for the WinCC SQL instance manually to "Automatic
(Delayed Start)" and restart the system.

3.8

HMI devices

3.8.1

Notes on HMI devices

Contents
Information that could not be included in the online help and important information about
product properties.

Unsupported HMI devices (as of TIA Portal V15)
All HMI devices with version 11.x are no longer supported as of TIA Portal V15.
The following HMI devices are no longer supported as of TIA Portal V15:
● WinAC MP 177, WinAC MP 277, WinAC MP 377
● Panels: OP and TP of the 70 series, 170 series and 270 series
● Multi Panels: Multi Panels of the 170 series, 270 series and 370 series
In order to use other devices in TIA Portal V15, for example Basic, Comfort or Mobile Panels,
that have been configured with version 11.x, change the device version of the device in
question.
The storage structure in the installation directory also no longer contains data for 11.0. This
helps to reduce the size of the TIA Portal installation package compared to the previous
versions.

Unsupported HMI devices (as of TIA Portal V15.1)
In addition to the devices that are not supported in TIA V15, the following devices are no longer
supported as of TIA Portal V15.1:
● WinCC Runtime Advanced V11
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Multi-key operation
Unintentional actions can be triggered by multi-key operation:
● When you are using a key device, you cannot press more than two function keys at the
same time.
● When you are using a touch device, a standard PC or a panel PC, you can only press one
function key or button at the same time.

HMI devices with high communication load
S7 Diagnostics should be enabled if a Panel is assigned many connections to PLCs or other
HMI devices. Otherwise, you will risk overload on the Panel.

TS Adapter with Ethernet interface
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory
settings.

Simulation with real PLC connection
The access point used by the simulation is independent from the settings of the engineering
system and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool.
If the PLC connection is terminated right after the start of the simulation with alarm 140001,
you should check the access point used by the simulation with "Setting PG/PC Interface".
1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens.
2. Select "S7ONLINE" in the "Access point of application" field as standard for HMI.
3. Select the interface in the "Interface Parameter Assignment Used" area.
4. Exit the "Set PG/PC Interface" dialog with OK.

Upgrading Basic Panels to device version V12
Before you upgrade Basic Panels from device version V11 to device version V12, transfer the
image of the V11 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings".
In this way, you always start a functional update of the image.
Affected devices:
● KP300 Basic mono PN
● KP400 Basic color PN
● KTP400 Basic color PN

Simulation of the Basic Panels
Use an output field in an alarm text to output an external tag. The content of this output field
will then always be displayed with "0" during simulation.
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Basic Panels 2nd Generation
Basic Panels 2nd Generation support the Sm@rtServer option.
If you are not using a USB hub, select the USB port USB_X60.1 as storage path.

HMI devices with operating system Windows CE 5.0 or higher
Owing to a modified client-server communication security setting, the time difference between
the HMI device (client) and PC (server) must not exceed 1 day. If you back up recipe data from
the HMI device on a network drive, for example, make sure that the time is set correctly on the
PC (server) and the HMI device (client).

Connection switch in the Control Panel with Basic Panels
If you use the "Override protected connection information" function, the following restriction
applies:
You cannot perform a connection switch in the Control Panel of a Basic Panel from a PLC
without a protection level to a PLC with a "Complete protection" level.

Mobile Panels 277F IWLAN
Mobile Panels 277F IWLAN are approved for use with CPUs of the type S7-1500F with WinCC
V13 SP1 Update 4.
If this connection is not established automatically after the panel is switched on or after a failsafe connection to a CPU S7-1500F is interrupted, a STOP/RUN transition needs to be
performed on the CPU.
Affected MLFBs:
● 6AV6645-0EB01-0AX1
● 6AV6645-0EC01-0AX1
● 6AV6645-0EF01-0AX1
● 6AV6645-0GB01-0AX1
● 6AV6645-0GC01-0AX1
● 6AV6645-0GF01-0AX1
● 6AV6645-0EF02-0AX1
● 6AV6645-0EF01-0AX1

Using Mobile Panel 277F IWLAN in the industrial environment
To avoid communication problems between the HMI device and access point, observe the
following:

Readme
Programming and Operating Manual, 10/2018

101

WinCC
3.8 HMI devices
IWLAN planning: Wireless connection between the HMI device and access point
● Wireless field planning needs to be carried out. Radar influences need to be taken into
consideration for channels requiring Dynamic Frequency Selection (DFS).
● Avoid radio frequency interference from other devices, such as hand-held devices with
Bluetooth or WLAN functionality.
● For adjacent access points, use data channels that are separated by at least one wireless
channel (e.g. 36 and 44 rather than 36 and 40).
● Do not place several access points in the immediately vicinity of one another. We
recommend a minimum distance of 5 m.
● For the Mobile Panel 277F IWLAN, use the "Software retry number" 15 instead of the default
value 3.
Using the "Rapid roaming" function with iPCF-MC
● Always use iPCF or iPCF-MC (rapid roaming) for PROFIsafe communication via
PROFINET.
● Use the same SSID for all access points.
● The "Background scan" should be switched off on the HMI device ("Background scan
interval" for the HMI device = 1 (default value)).
● Use the same "Management channel" and different, non-overlapping "Data channels" for
all access points.
● Configure the "PN-IO cycle time" higher than the "iPCF scan cycle time".
● Observe the configured timeout when assigning PROFIsafe parameters.

"Zone ID/Connection point ID" tag of a Mobile Panel 277 IWLAN V2
The tag used for the "Zone ID/Connection point ID" must be of data type INT for Mobile Panel
277 IWLAN V2 devices. Adapt this data type if necessary when migrating a project.

Mobile Panels 277F IWLAN (RFID tag): F_DB_STATES
The F_DB_STATES block is no longer supplied with WinCC V14. The block F_DB_STATES
serves only for data exchange. You can configure an F_DB to replicate the function of the
F_DB_STATES. Note the description of the F_DB_STATES in the operating instructions of
your HMI device or in the information system.

IPC427D
If an IPC427D is configured in a V12 or V13 project in which IE1 of the PC station is assigned
and the device version of the PC station changes from V1 to V2 after upgrading to V14, the
interface assignment of CP_IE_1 must initially be set to "None, or different Windows settings"
and then changed to "SIMATIC PC Station" before compiling the project . Then, the project
can be compiled without errors.
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Printing alarms (Mobile Panels 2nd Generation)
It is not possible to print alarms as PDF or HTML when the internal memory "/flash" is selected
as "Storage Location". To print alarms as PDF or HTML, select an SD memory card or a USB
stick as storage location.

DHCP on KTP 400 PN, KTP 700 PN and KTP 900 PN
Operation with DHCP is not recommended for the KTP 400 PN, KTP 700 PN and KTP 900
PN devices.
In some circumstances, it is possible that the device will no longer boot. If that is the case,
detach the network cable and reboot the device. After it has successfully started up, please
assign a fixed IP address.

2nd Generation Mobile Panels
Mobile Panels 2nd Generation can be configured with TIA Portal V15.1 in device version V15.
The compiled project cannot be downloaded to these devices, however.
An upgrade to device version V15.1 is required to work with Mobile Panels 2nd Generation in
TIA Portal V15.1.

Sm@rtServer with Mobile Panels 2nd Generation
As of WinCC V15.1 the Sm@rtServer option is available and configurable for all 2nd generation
Mobile Panels without a license. See the important notes in the Siemens Industry Online
Support entry ID 109758056 (https://support.industry.siemens.com/cs/ww/en/view/
109758056).

Sm@rtServer with KTP Mobile Panels
The evaluation of the safety operation via PROFIsafe is only guaranteed if the Sm@rtServer
is disabled on the panel.
The use of Sm@rtServer on devices without a safety function is not recommended.

Simulation of Basic Panels 2nd Generation
3D hardware acceleration of the graphics card should be enabled for simulating the Basic
Panels 2nd Generation.

Installing fonts
If you have installed new fonts on a panel with Prosave, you will need to restart the panel. The
duration of the runtime startup process depends on the number and size of fonts.

Interruption of the DH485 connection
If you connect the Ethernet cable to the "PN_X1" connector of the HMI panel with Comfort
Panels, the DH485 connection may be interrupted.
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Remedy for Comfort Redesign/PRO Panels: When running the DH485 project on the HMI
Panel, use the connector "PN_X3(Gigabit)" for Ethernet communication.

Sm@rtServer with Fail-safe Mobile Panels KTP400F/700F/900F Mobile
For correct evaluation of safety-related operation, ensure that Sm@rtServer is disabled on the
HMI device.

Configure secure e-mail notification from Runtime
E-mails encrypted with TLS1.2 can be sent as of TIA Portal V14 on Comfort Panels and KTP
Mobile Panels.

3.9

Add-ons

3.9.1

Sm@rtServer

Content
Information that could not be included in the online help and important information about
product features.

File size for file broswer
The maximum file size for upload or download is 2 GB.

Opening SmartClient *.sac files under Windows 10
You save the data of the current SmartServer connection using the executable file
SmartClient.exe with the *.sac format. To open the files generated in this way automatically
under Windows 10, a *.sac file with SmartClient.exe must be opened once manually via the
selection button and dialog in SmartClient.exe.

3.9.2

Audit

Contents
Information that could not be included in the online help and important information about
product properties.
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WinCC Audit Viewer 7.2 Update
An update for manual installation is available for WinCC Audit Viewer 7.2, which can be
installed optionally.
Install the update for WinCC Audit Viewer 7.2 by running the "AuditViewer_V72_00_Upd1.exe"
file from the Support directory on the product DVD.

3.9.3

DataMonitor

Contents
Information that could no longer be included in the online help and important information about
product features.

Removal of WinCC Runtime
If you also want to use DataMonitor after removing WinCC Runtime Professional, you have to
perform a repair of the installation as follows:
1. Open the Control Panel.
2. Double-click on "Add/Remove Programs".
3. Select "SIMATIC WinCC/DataMonitor client" in the list of programs installed
4. Click on the "Change/Remove" button.
5. Select the setting "Repair" in the WinCC DataMonitor setup.

Name of the user groups
The name of the user groups differs at certain locations of the Online Help from the actually
created user groups. The following assignment is valid:
SIMATIC Report Administrators corresponds to DM_Admin
SIMATIC Report Users corresponds to DM_User

Excel-Workbook on a PC with Windows 7
If you operate Excel-Workbook on a PC with Windows 7, you need to disable the "Aero Glass"
display mode.

Importing configuration data
If you load a project to a device via an external data medium, DataMonitor cannot export a
correct XML file on this device.
The exported XML file can then no longer be used for importing configuration data.
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Channel diagnostics view
The "Channel diagnostics view" object is not supported by the option WinCC DataMonitor.

3.9.4

WebNavigator

Contents
Information that could not be included in the online help and important information about
product features.

Removal of WinCC Runtime
If you also want to use WebNavigator after removing WinCC Runtime Professional, you have
to perform a repair of the installation as follows:
1. Open the Control Panel.
2. Double-click on "Add/Remove Programs".
3. Select "SIMATIC WinCC/WebNavigator client" in the list of programs installed
4. Click on the "Change/Remove" button.
5. Select the setting "Repair" in the WinCC/WebNavigator setup".

WebNavigator Client Manual logoff
Users can now also log off manually from the WebNavigator client using the ODK function
"PWRTLogout()". You can find one description of the function in the Runtime API
documentation under "Functions of the user administration > Functions for logon, logoff".

Virus scanner Trend Micro OfficeScan
It is not recommended to use the virus scanner of Trend Micro OfficeScan in combination with
WebNavigator, as this virus scanner may have an adverse impact on screen loading times.

ProDiag overview, GRAPH overview and PLC code view
The WinCC option Web Navigator does not support the use of the WinCC objects "GRAPH
overview", "ProDiag overview" and "PLC code view".

Time zone of Web parts
When you create and configure a Web part in a specific time zone in the Web center, the time
zone is stored in the Web center.
If the time zone is changed in the operating system, this can lead to an incorrect display of the
time in the Web part.
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Characters not permitted in WinCC WebNavigator
Use the characters of the ASCII character set in the picture names and project names. Do not
use any special characters or national special characters.

Channel diagnostics
The object "Channel diagnostics" is not supported by the option WinCC WebNavigator.

Automatic trigger for SmartTags in scripts
Use the automatic trigger if you use SmartTags in scripts in the WebNavigator screens.

Delay when outputting the WebNavigator screens
Due to the Web server technology, it may occur that updated WebNavigator screens are output
with a delay in Runtime.

New function for WebNavigator client
As of TIA Portal Version V15.1, you have the option to define a start screen and a start language
for WebNavigator client in the ActiveX control UserAdminControl.

3.9.5

WebUX

Content
Information that could not be included in the online help and important information about
product features.

Update cycles
When accessing via WebUX, the refresh of the dynamics that use the screen cycle is always
2 seconds, even if a different screen cycle is configured.

Automatic login
If automatic login is no longer desired, you must delete the browser history in the respective
browser.

New function for WebUX client
As of TIA Portal Version V15.1, you have the option to define a start screen and a start language
for WebUX client in the ActiveX control UserAdminControl.
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3.9.6

Redundancy

Contents
Information that could not be included in the online help and important information about
product features.

Name in configuration of a redundant system
Only the computer name of the HMI devices is relevant for the configuration of a redundant
system. You set the computer name of the HMI device in its operating system. The name of
the HMI device from the project tree is only used for identification of the HMI device in the
project.

3.9.7

SIMATIC Information Server

Contents
Information that could not be included in the online help and important information about
product features.

Installation of SIMATIC Information Server and WinCC Runtime Professional on one PC
To set up the SIMATIC Information Server and WinCC Runtime Professional on one PC,
adhere to the following installation sequence:
1. Install WinCC Runtime Professional.
2. Install the Information Server.
If you do not follow the installation sequence, connection problems may occur.
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